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Chapter 1 

 
Computer Basics 

 
This chapter lays a foundation for one of the most influential forces available in 

modern times, the computer. A computer is an electronic device, operating under 

the control of instructions, which tells the machine what to do. It is capable of ac- 

cepting data (input), processing data arithmetically and logically, producing output 

from the processing, and storing the results for future use. The chapter begins with 

the characteristics, evolution, and various generations of computers. The discus- 

sion also explores the classification of computers and their features. The chapter 

concludes with an overview on basic computer units and computer applications. 

 

1.1 Introduction 

 
In the beginning of the civilization, people used fingers and pebbles for computing 

purposes. In fact, the word digits in Latin actually means finger and calculus 

means pebble. This gives a clue into the origin of early computing concepts. With 

the development of civilization, the computing needs also grew. The need for a 

mechanism to perform lengthy calculations led to the invention of, first, calculator 

and then computers. 
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The term computer is derived from the word compute, which means to calculate. 

A computer is an electronic machine devised for performing calculations and con- 

trolling operations that can be expressed either in logical or in numerical terms. In 

simple words, a computer is an electronic device that performs diverse opera- 

tions with the help of instructions to process the data in order to achieve desired 

results. Although the application domain of a computer depends totally on human 

creativity and imagination, it covers a huge area of applications including educa- 

tion, industries, government, medicine, scientific research, law, and even music 

and arts. 

Computers are one of the most influential forces available in modern times. Har- 

nessing the power of computers enables relatively limited and fallible human ca- 

pacities for memory, logical decision making, reaction and perfection to be ex- 

tended to almost infinite levels. Millions of complex calculations can be done in 

a mere fraction of time; difficult decisions can be made with unerring accuracy 

for comparatively little cost. Computers are widely seen as instruments for fu- ture 

progress and as tools to achieve sustainability by way of improved access to 

information with the help of video-conferencing and e-mail. Indeed, computers 

have left such an impression on modern civilization that we call this era as the 

“information age”. 

 
1.1.1 Characteristics of Computers 

 
The human race developed computers so that it could perform intricate operations, 

such as calculation and data processing, or simply for entertainment. Today, much 

of the world’s infrastructure runs on computers and it has profoundly changed our 

lives, mostly for the better. Let us discuss some of the characteristics of comput- 

ers, which make them an essential part of every emerging technology and such a 

desirable tool in human development. 
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• Speed: The computers process data at an extremely fast rate, at millions or 

billions of instructions per second. A computer can perform a huge task in 

a few seconds that otherwise a normal human being may take days or even 

years to complete. The speed of a computer is calculated in MHz (mega- 

hertz), that is, one million instructions per second. At present, a powerful 

computer can perform billions of operations in just one second. 

• Accuracy: Besides the efficiency, the computers are also very accurate. The 

level of accuracy depends on the instructions and the type of machines being 

used. Since the computer is capable of doing only what it is instructed to do, 

faulty instructions for data processing may lead to faulty results. This is 

known as Garbage In Garbage Out (GIGO). 

• Diligence: Computer, being a machine, does not suffer from the human traits 

of tiredness and lack of concentration. If four million calculations have to be 

performed, then the computer will perform the last four-millionth calculation 

with the same accuracy and speed as the first calculation. 

• Reliability: Generally, reliability is the measurement of the performance of 

a computer, which is measured against some predetermined standard for op- 

eration without any failure. The major reason behind the reliability of the 

computers is that, at hardware level, it does not require any human interven- 

tion between its processing operations. Moreover, computers have built-in 

diagnostic capabilities, which help in the continuous monitoring of the sys- 

tem. 

• Storage Capability: Computers can store large amounts of data and can 

recall the required information almost instantaneously. The main memory of 

the computer is relatively small and it can hold only a certain amount of data; 

therefore, the data are stored on secondary storage devices such as magnetic 

tape or disks. Small sections of data can be accessed very quickly from these 
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storage devices and brought into the main memory, as and when required, 

for processing. 

• Versatility: Computers are quite versatile in nature. It can perform multiple 

tasks simultaneously with equal ease. For example, at one moment it can be 

used to draft a letter, another moment it can be used to play music and in 

between, one can print a document as well. All this work is possible by 

changing the program (computer instructions). 

• Resource Sharing: In the initial stages of development, computers used to 

be isolated machines. With the tremendous growth in computer technologies, 

computers today have the capability to connect with each other. This has 

made the sharing of costly resources like printers possible. Apart from device 

sharing, data and information can also be shared among groups of computers, 

thus creating a large information and knowledge base. 

 
Although processing has become less tedious with the development of computers, 

it is still a time-consuming and expensive job. Sometimes, a program works 

properly for some period and then suddenly produces an error. This happens 

because of a rare combination of events or due to an error in the instruction provided 

by the user. Therefore, computer parts require regular checking and maintenance in 

order to give correct results. Furthermore, computers need to be installed in a dust-

free place. Generally, some parts of computers get heated up due to heavy 

processing. Therefore, the ambient temperature of the computer system should be 

maintained. 

 

1.2 Generations of Computers 

 
The history of computer development is often discussed with reference to the 

different generations of computing devices. In computer terminology, the word 

generation is described as a stage of technological development or innovation. A 
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major technological development that fundamentally changed the way computers 

operate, resulting in increasingly smaller, cheaper, more powerful, and more efficient 

and reliable devices, characterizes each generation of computers. According to the 

type of “processor” installed in a machine, there are five generations of computers. 

 
1.2.1 First Generation (1940 to 1956): Vacuum Tubes 

 
First-generation computers were vacuum tubes/thermionic valve-based machines. 

These computers used vacuum tubes for circuitry and magnetic drums for memory. 

A magnetic drum is a metal cylinder coated with magnetic iron oxide material on 

which data and programs can be stored. The input was based on punched cards and 

paper tape, and the output was in the form of printouts (see Figure 1.1) 

Figure 1.1: Vacuum tube 

 
 

First-generation computers relied on binary-coded language also called machine 

language (language of 0s and 1s) to perform operations and were able to solve only 

one problem at a time. Each machine was fed with different binary codes and hence, 

were difficult to program. This resulted in lack of versatility and speed. In addition, 

to run on different types of computers, instructions must be rewritten or recompiled. 

Examples: ENIAC, EDVAC and UNIVAC. 

 
Characteristics of First-generation Computers: 

 
• These computers were based on vacuum tube technology. 



Computer Basics 

– Page 6 – 

 

 

• These were the fastest computing devices of their times (computation time 

was in milliseconds). 

• These computers were very large and required a lot of space for installation. 

 
• Since thousands of vacuum tubes were used, they generated a large amount 

of heat. Therefore, air conditioning was essential. 

• These were non-portable and very slow equipments. 

 
• They lacked in versatility and speed. 

 
• They were very expensive to operate and used a large amount of electricity. 

 
• These machines were unreliable and prone to frequent hardware failures. 

Hence, constant maintenance was required. 

• Since machine language was used, these computers were difficult to program 

and use. 

• Each individual component had to be assembled manually. Hence, commer- 

cial appeal of these computers was poor. 

 
1.2.2 Second Generation (1956 to 1963): Transistors 

 
Second-generation computers used transistors, which were superior to vacuum 

tubes. A transistor is made up of semiconductor material like germanium and 

silicon. It usually has three leads (see Figure 1.2) and performs electrical 

functions such as voltage, current or power amplification with low power 

requirements. Since a transistor is a small device, the physical size of computers 

was greatly reduced. Computers became smaller, faster, cheaper, energy 

efficient and more reliable than their predecessors. In second-generation 

computers, magnetic cores were used as the primary memory and magnetic disks 

as the secondary storage devices. However, they still relied on punched cards for 

the input and printouts for the output. 
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Figure 1.2: Transistor 

 
 

One of the major developments of this generation includes the progress from ma- 

chine language to assembly language. Assembly language uses mnemonics 

(abbreviations) for instructions rather than numbers, for example, ADD for 

addition and MULT for multiplication. As a result, programming became less 

cumber- some. Early high-level programming languages such as COBOL and 

FORTRAN also came into existence in this period. 

Examples: PDP-8, IBM 1401 and IBM 7090. 

 
Characteristics of Second-generation Computers 

 
• These machines were based on transistor technology. 

 
• These were smaller as compared to the first-generation computers. 

 
• The computational time of these computers was reduced to microseconds 

from milliseconds. 

• These were more reliable and less prone to hardware failure. Hence, they 

required less frequent maintenance. 

• These were more portable and generated less amount of heat. 

 
• Assembly language was used to program computers. Hence, programming 

became more time-efficient and less cumbersome. 

• Second-generation computers still required air conditioning. 
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• Manual assembly of individual components into a functioning unit was still 

required. 

 
1.2.3 Third Generation (1964 to Early 1970s): Integrated Circuits 

 
The development of the integrated circuit, also called an IC, was the trait of the 

third-generation computers. An IC consists of a single chip (usually silicon) with 

many components such as transistors and resistors fabricated on it. ICs replaced 

several individually wired transistors. This development made computers smaller 

in size, reliable and efficient (see Figure 1.3). 

Figure 1.3: Integrated Circuit (IC) 

 
 

Instead of punched cards and printouts, users interacted with third-generation com- 

puters through keyboards and monitors, and interfaced with the operating system. 

This allowed the device to run many different applications simultaneously with a 

central program that monitored the memory. For the first time, computers became 

accessible to mass audience because they were smaller and cheaper than their pre- 

decessors. 

Examples: NCR 395 and B6500. 

 
Characteristics of Third-generation Computers 

 
• These computers were based on IC technology. 

 
• These were able to reduce the computational time from microseconds to 

nanoseconds. 
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• These were easily portable and more reliable than the second-generation 

computers. 

• These devices consumed less power and generated less heat. In some cases, 

air conditioning was still required. 

• The size of these computers was smaller as compared to previous-generation 

computers. 

• Since hardware rarely failed, the maintenance cost was quite low. 

 
• Extensive use of high-level languages became possible. 

 
• Manual assembling of individual components was not required, so it reduced the 

large requirement of labour and cost. However, highly sophisticated tech- 

nologies were required for the manufacturing of IC chips. 

• Commercial production became easier and cheaper. 

 
 

1.2.4 Fourth Generation (Early 1970s to Till Date): Microprocessors 

 
The fourth generation is an extension of third generation technology. Although, 

the technology of this generation is still based on the IC, these have been made 

readily available to us because of the development of the microprocessor (circuits 

containing millions of transistors). The Intel 4004 chip, which was developed in 

1971, took the IC one step further by locating all the components of a computer 

(CPU, memory and I/O controls) on a minuscule chip. A microprocessor is built 

on to a single piece of silicon, known as chip. It is about 0.5 cm along one side 

and no more than 0.05 cm thick. 

The fourth-generation computers led to an era of Large Scale Integration (LSI) 

and VLSI technology. LSI technology allowed thousands of transistors to be 

constructed on one small slice of silicon material, whereas VLSI squeezed hundreds 

of
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thousands of components on to a single chip. Ultra Large Scale Integration (ULSI) 

increased that number to the millions. This way computers became smaller and 

cheaper than ever before (see Figure 1.4). 

Figure 1.4: Microprocessor 

 
 

The fourth-generation computers became more powerful, compact, reliable and 

affordable. As a result, it gave rise to the PC revolution. During this period, mag- 

netic core memories were substituted by semiconductor memories, which resulted 

in faster random access main memories. Moreover, secondary memories such as 

hard disks became economical, smaller and bigger in capacity. The other signifi- 

cant development of this era was that these computers could be linked together to 

form networks, which eventually led to the development of the Internet. This gen- 

eration also saw the development of the Graphical User Interfaces (GUIs), mouse 

and handheld devices. Despite many advantages, this generation required com- 

plex and sophisticated technology for the manufacturing of the CPU and the other 

components. 

Examples: Apple II, Altair 8800 and CRAY-1. 

 
Characteristics of Fourth-generation Computers 

 
• These computers are microprocessor-based systems. 

 
• These are very small in size. 

 
• These are the cheapest among all the other generation computers. 

 
• These are portable and quite reliable. 
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• These machines generate negligible amount of heat, hence do not require air 

conditioning. 

• Hardware failure is negligible so minimum maintenance is required. 

 
• The production cost is very low. 

 
• The GUI and pointing devices enabled users to learn to use the computer 

quickly. 

• Interconnection of computers led to better communication and resource shar- 

ing. 

 
1.2.5 Fifth Generation (Present and Beyond): Artificial Intelligence 

 
The dream of creating a human-like computer that would be capable of reasoning 

and reaching at a decision through a series of what-if-then analyses has existed since 

the beginning of computer technology. Such a computer would learn from its 

mistakes and possess the skill of experts. These are the objectives for creating the 

fifth generation of computers. The starting point for the fifth generation of com- 

puters had been set in the early 1990s. The process of developing fifth-generation 

computers is still in the development stage. However, the expert system concept 

is already in use. The expert system is defined as a computer system that attempts 

to mimic the thought process and reasoning of experts in specific areas. Three 

characteristics can be identified with the fifth-generation computers. These are: 

 
• Mega Chips: Fifth-generation computers will use Super Large Scale In- 

tegrated (SLSI) chips, which will result in the production of microproces- 

sors having millions of electronic components on a single chip. In order to 

store instructions and information, fifth-generation computers require a great 

amount of storage capacity. Mega chips may enable the computer to approx- 

imate the memory capacity of the human mind. 
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• Parallel Processing: Computers with one processor access and execute only 

one instruction at a time. This is called serial processing. However, fifth- 

generation computers will use multiple processors and perform parallel pro- 

cessing, thereby accessing several instructions at once and working on them 

at the same time. 

• Artificial Intelligence (AI): It refers to a series of related technologies that 

try to simulate and reproduce human behavior, including thinking, speaking 

and reasoning. AI comprises a group of related technologies: expert systems 

(ES), natural language processing (NLP), speech recognition, vision recog- 

nition and robotics. 

 

1.3 Classification of Computers 

 
These days, computers are available in many sizes and types. Some computers can 

fit in the palm of the hand, while some can occupy the entire room. Computers 

also differ based on their data-processing abilities. Based on the physical size, 

performance and application areas, we can generally divide computers into four 

major categories: micro, mini, mainframe and supercomputers (see Figure 1.5). 

Figure 1.5: Classification of Computers 

 

 
1.3.1 Microcomputers 

 
A microcomputer is a small, low-cost digital computer, which usually consists of 

a microprocessor, a storage unit, an input channel and an output channel, all of 
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which may be on one chip inserted into one or several PC boards. The addition of 

power supply and connecting cables, appropriate peripherals (keyboard, monitor, 

printer, disk drives and others), an operating system and other software programs 

can provide a complete microcomputer system. The micro-computer is generally 

the smallest of the computer family. Originally, these were designed for individual 

users only, but nowadays they have become powerful tools for many businesses 

that, when networked together, can serve more than one user. IBM-PC Pentium 

100, IBM-PC Pentium 200 and Apple Macintosh are some of the examples of 

microcomputers. Microcomputers include desktop, laptop and hand-held models 

such as Personal Digital Assistants (PDAs). 

Desktop Computer: The desktop computer, also known as the PC, is principally 

intended for stand-alone use by an individual. These are the most-common type 

of microcomputers. These microcomputers typically consist of a system unit, a 

display monitor, a keyboard, an internal hard disk storage and other peripheral 

devices. The main reason behind the importance of the PCs is that they are not 

very expensive for the individuals or the small businesses. Some of the major PC 

manufacturers are APPLE, IBM, Dell and Hewlett-Packard (see Figure 1.6). 

Figure 1.6: Desktop Computer 

 
 

Laptop: A laptop is a portable computer that a user can carry around. Since the 

laptop resembles a notebook, it is also known as the notebook computer. Laptops 
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are small computers enclosing all the basic features of a normal desktop computer. 

The biggest advantage of laptops is that they are lightweight and one can use them 

anywhere and at anytime, especially when one is travelling. Moreover, they do 

not need any external power supply as a rechargeable battery is completely self- 

contained in them. However, they are expensive as compared to desktop computers 

(see Figure 1.7). 

Figure 1.7: Laptop 

 

 
1.3.2 Minicomputers 

 
In the early 1960s, Digital Equipment Corporation (DEC) started shipping its PDP 

series computer, which the press described and referred to as minicomputers. A 

minicomputer is a small digital computer, which normally is able to process and 

store less data than a mainframe but more than a microcomputer, while doing so 

less rapidly than a mainframe but more rapidly than a microcomputer. It is about 

the size of a two-drawer filing cabinet. Generally, these computers are used as 

desktop devices that are often connected to a mainframe in order to perform the 

auxiliary operations (see Figure 1.8). 
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Figure 1.8: Minicomputer 

 
 

A minicomputer (sometimes called a mid-range computer) is designed to meet the 

computing needs of several people simultaneously in a small- to medium-sized 

business environment. It is capable of supporting from four to about 200 simulta- 

neous users. It serves as a centralized storehouse for a cluster of workstations or as 

a network server. Minicomputers are usually multi-user systems so these are used 

in interactive applications in industries, research organizations, colleges and uni- 

versities. They are also used for real-time controls and engineering design work. 

Some of the widely used minicomputers are PDP 11, IBM (8000 series) and VAX 

7500. 

 
1.3.3 Mainframes 

 
A mainframe is an ultra-high performance computer made for high-volume, processor- 

intensive computing. It consists of a high-end computer processor, with related 

peripheral devices, capable of supporting large volumes of data processing, high- 

performance online transaction processing, and extensive data storage and re- 

trieval. Normally, it is able to process and store more data than a minicomputer 

and far more than a microcomputer. Moreover, it is designed to perform at a faster 

rate than a minicomputer and at even more faster rate than a microcomputer. Main- 

frames are the second largest (in capability and size) of the computer family, the 
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largest being the supercomputers. However, mainframes can usually execute many 

programs simultaneously at a high speed, whereas supercomputers are designed 

for a single process (see Figure 1.9). 

Figure 1.9: Mainframe 

 
 

The mainframe allows its users to maintain a large amount of data storage at a 

centralized location and to access and process these data from different computers 

located at different locations. It is typically used by large businesses and for sci- 

entific purposes. Some examples of the mainframe are IBM’s ES000, VAX 8000 

and CDC 6600. 

 
1.3.4 Supercomputers 

 
Supercomputers are the special-purpose machines, which are especially designed 

to maximize the numbers of floating point operations per second (FLOPS). Any 

computer below one gigaflop per second is not considered a supercomputer. A su- 

percomputer has the highest processing speed at a given time for solving scientific 

and engineering problems. Essentially, it contains a number of CPUs that oper- 

ate in parallel to make it faster. Its processing speed lies in the range 40010,000 

MFLOPS (millions of floating point operations per second).   Due to this fea- ture, 

supercomputers help in many applications including information retrieval and 

computer-aided designing (see Figure 1.10). 
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Figure 1.10: Supercomputer 

 
 

A supercomputer can process a great deal of data and make extensive calcula- 

tions very quickly. It can resolve complex mathematical equations in a few hours, 

which would have taken many years when performed using a paper and pencil or 

using a hand calculator. It is the fastest, costliest and most powerful computer 

available today. Typically, supercomputers are used to solve multivariant mathe- 

matical problems of existent physical processes, such as aerodynamics, metrology 

and plasma physics. They are also required by the military strategists to simulate 

defence scenarios. Cinematic specialists use them to produce sophisticated movie 

animations. Scientists build complex models and simulate them in a supercom- 

puter. However, a supercomputer has limited broad-spectrum use because of its 

price and limited market. The largest commercial uses of supercomputers are in 

the entertainment/advertising industry. CRAY-3, Cyber 205 and PARAM are some 

well-known supercomputers. 

 

1.4 The Computer System 

 
A computer can be viewed as a system, which consists of a number of interrelated 

components that work together with the aim of converting data into information. 

In a computer system, processing is carried out electronically, usually with little or 

no intervention from the user. 

The general perception of people regarding the computer is that it is an “intelli- 
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gent thinking machine”. However, this is not true. Every computer needs to be 

instructed exactly what to do and how to do. The instructions given to computers 

are called programs. Without programs, computers would be useless. The physical 

parts that make up a computer (the CPU, input, output and storage unit) are known 

as hardware. Any hardware device connected to the computer or any part of the 

computer outside the CPU and working memory is known as a peripheral. Some 

examples of peripherals are keyboards, mouse and monitors. 

 
1.4.1 Components of a Computer System 

 
There are several computer systems in the market with a wide variety of makes, 

models and peripherals. In general, a computer system comprises the following 

components: 

 
• CPU: This unit performs processing of instructions and data inside the com- 

puter. 

• Input Unit: This unit accepts instructions and data. 

 
• Output Unit: This unit communicates the results to the user. 

 
• Storage Unit: This unit stores temporary and final results (see Figure 1.11). 

 
 

Figure 1.11: Components of a Computer System 

 
 

Central Processing Unit: The CPU, also known as a processor, is the brain of 
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the computer system that processes data (input) and converts it into meaningful 

information (output). It is referred to as the administrative section of the computer 

system that interprets the data and instructions, coordinates the operations, and 

supervises the instructions. The CPU works with data in discrete form, that is, 

either 1 or 0. It counts, lists, compares and rearranges the binary digits of data 

in accordance with the detailed program instructions stored within the memory. 

Eventually, the results of these operations are translated into characters, numbers 

and symbols that can be understood by the user. The CPU itself has three parts: 

• Arithmetic Logic Unit (ALU): This unit performs the arithmetic (add, sub- 

tract) and logical operations (and, or) on the data made available to it. When- 

ever an arithmetic or logical operation is to be performed, the required data 

are transferred from the memory unit to the ALU, the operation is performed 

and the result is returned to the memory unit. Before the completion of the 

processing, data may need to be transferred back and forth several times be- 

tween these two sections. 

• Control Unit: This unit checks the correctness of the sequence of opera- 

tions. It fetches the program instructions from the memory unit, interprets 

them and ensures correct execution of the program. It also controls the I/O 

devices and directs the overall functioning of the other units of the computer. 

• Registers: These are the special-purpose, high-speed temporary memory 

units that can hold varied information such as data, instructions, addresses 

and intermediate results of calculations. Essentially, they hold the informa- 

tion that the CPU is currently working on. The registers can be considered 

as the CPU’s working memory, an additional storage location that provides 

the advantage of speed. 

Note: The circuits necessary to create a CPU for a PC are fabricated on a micro- 

processor. 
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Input, Output and Storage Unit: The user must enter instructions and data into 

the computer system before any operation can be performed on the given data. 

Similarly, after processing the data, the information must go out from the computer 

system to the user. For this, every computer system incorporates the I/O unit that 

serves as a communication medium between the computer system and the user. 

An input unit accepts instructions and data from the user with the help of input 

devices such as keyboard, mouse, light pen, etc. Since the data and instructions 

entered through different input devices will be in different form, the input unit 

converts them into the form that the computer can understand. After this, the input 

unit supplies the converted instructions and data to the computer for further 

processing. 

The output unit performs just opposite to that of input unit. It accepts the output 

(which is in machine-coded form) produced by the computer, converts them into 

the user-understandable form and supplies the converted results to the user with 

the help of an output device such as printer, monitor and plotter. 

Besides, a computer system incorporates a storage unit to store the input entered 

through the input unit before processing starts and to store the results produced by 

the computer before supplying them to the output unit. The storage unit of a 

computer comprises two types of memory/storage: primary and secondary. The 

primary memory, also called the main memory, is the part of a computer that holds 

the instructions and data currently being processed by the CPU, the intermediate 

results produced during the course of calculations and the recently processed data. 

While the instructions and data remain in the main memory, the CPU can access 

them directly and quickly. However, the primary memory is quite expensive and 

has a limited storage capacity. 

Due to the limited size of the primary memory, a computer employs the secondary 

memory, which is extensively used for storing data and instructions. It supplies 
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the stored information to the other units of the computer as and when required. It 

is less expensive and has higher storage capacity than the primary memory. Some 

commonly used secondary storage devices are floppy disks, hard disks and tape 

drives (see Figure 1.12). 

Figure 1.12: Typical Hardware and Peripherals in a Computer System 

 

 
1.4.2 How Does a Computer Work? 

 
A computer performs three basic steps to complete any task: input, processing and 

output. A task is assigned to a computer in a set of step-by-step instructions, which 

is known as a program. These instructions tell the computer what to do with the 

input in order to produce the required output. A computer functions in the following 

manner: 

• Step 1: The computer accepts the input. The computer input is whatever 

entered or fed into a computer system. The input can be supplied by the user 

(such as by using a keyboard) or by another computer or device (such as a 

diskette or CD-ROM). Some examples of input include the words and sym- 

bols in a document, numbers for a calculation, instructions for completing a 

process, and so on. 

• Step 2: The computer processes the data. During this stage, the computer 

follows the instructions using the data that have been input. Examples of 

processing include calculations, sorting lists of words or numbers and modi- 

fying documents according to user instructions. 
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• Step 3: The computer produces output. Computer output is the information 

that has been produced by a computer. Some examples of computer output 

include reports, documents and graphs. Output can be in several formats, 

such as printouts, or displayed on the screen (see Figure 1.13). 

 

Figure 1.13: Basic Computer Operations 

 

 
1.5 Applications of Computers 

 
In the last few decades, computer technology has revolutionized the businesses and 

other aspects of human life all over the world. Practically, every company, large 

or small, is now directly or indirectly dependent on computers for data processing. 

Computer systems also help in the efficient operation of railway and airway reser- 

vation, hospital records, accounts, electronic banking and so on. Computers not 

only save time, but also save paper work. Some of the areas where computers are 

being used are listed below. 

 
• Science: Scientists have been using computers to develop theories, to anal- 

yse and to test the data. The fast speed and the accuracy of the computer 

allow different scientific analyses to be carried out. They can be used to gen- 

erate detailed studies of how earthquakes affect buildings or pollution affects 

weather pattern. Satellite-based applications would not have been possible 

without the use of computers. It would also not be possible to get the infor- 

mation of our solar system and the cosmos without computers. 

• Education: Computers have also revolutionized the whole process of educa- 

tion. Currently, the classrooms, libraries and museums are utilizing computers 
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to make the education much more interesting. Unlike recorded television 

shows, computer-aided education (CAE) and computer-based training (CBT) 

packages are making learning much more interactive. 

• Medicine and Healthcare: There has been an increasing use of computers 

in the field of medicine. Now, doctors are using computers right from di- 

agnosing the illness to monitoring a patient’s status during complex surgery. 

By using automated imaging techniques, doctors are able to look inside a 

person’s body and can study each organ in detail (such as CAT scans or MRI 

scans), which was not possible few years ago. There are several examples of 

special-purpose computers that can operate within the human body such as a 

cochlear implant, a special kind of hearing aid that makes it possible for deaf 

people to hear. 

• Engineering/Architecture/Manufacturing: The architects and engineers 

are extensively using computers in designing and drawings. Computers can 

create objects that can be viewed from all the three dimensions. By using 

techniques like virtual reality, architects can explore houses that have been 

designed but not built. The manufacturing factories are using computerized 

robotic arms in order to perform hazardous jobs. Besides, computer-aided 

manufacturing (CAM) can be used in designing the product, ordering the 

parts and planning production. Thus, computers help in coordinating the 

entire manufacturing process. 

• Entertainment: Computers are finding greater use in the entertainment in- 

dustry. They are used to control the images and sounds. The special effects, 

which mesmerize the audience, would not have been possible without the 

computers. In addition, computerized animation and colourful graphics have 

modernized the film industry. 

• Communication: E-mail or electronic mail is one of the communication me- 

dia in which computers are used. Through an e-mail, messages and reports 
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are passed from one person to one or more persons with the aid of computers 

and telephone lines. The advantage of this service is that while transferring 

the messages it saves time, avoids wastage of paper, and so on. Moreover, 

the person who is receiving the messages can read the messages whenever 

he is free and can save it, reply it, forward it or delete it from the computer. 

• Business Application: This is one of the important uses of the computer. 

Initially, computers were used for batch processing jobs, where one does not 

require the immediate response from the computer. Currently, comput- ers 

are mainly used for real-time applications (like at the sales counter) that 

require immediate response from the computer. There are various concerns 

for which computers are used such as in business forecasting, to prepare pay 

bills and personal records, in banking operations and data storage, in various 

types of life insurance business, and as an aid to management. Businesses are 

also using the networking of computers, where a number of computers are 

connected together to share the data and the information. Use of an e-mail 

and the Internet has changed the ways of doing business. 

• Publishing: Computers have created a field known as Desktop Publishing 

(DTP). In DTP, with the help of a computer and a laser printer one can per- 

form the publishing job all by oneself. Many of the tasks requiring long 

manual hours, such as making a table of contents and an index, can be auto- 

matically performed using the computers and DTP software. 

• Banking: In the field of banking and finance, computers are extensively 

used. People can use the Automated Teller Machine (ATM) services 24 hours 

a day in order to deposit and withdraw cash. When the different branches 

of the bank are connected through the computer networks, the inter-branch 

transactions, such as drawing cheques and making drafts, can be performed 

by the computers without any delay 
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Let Us Summarize 

 
1. Computer is an electronic device that performs diverse operations with the 

help of instructions to process the data in order to achieve desired results. 

Speed, accuracy, reliability, versatility, diligence, storage capability and re- 

source sharing characterize the computers. 

2. Many devices, which humans developed for their computing requirements, 

preceded computers. Some of those devices were Sand Tables, Abacus, 

Napier Bones, Slide Rule, Pascaline, Stepped Reckoner, Difference Engine, 

Analytical Engine and Hollerith’s Tabulator. 

3. Computer development is divided into five main generations. With every 

generation, computer technology has fundamentally changed, resulting in an 

increasingly smaller, cheaper, more powerful, more efficient and reliable 

devices. 

4. First-generation computers were vacuum tube based machines. These com- 

puters were very large, required a lot of space for installation, generated 

a large amount of heat were non-portable and have very slow equipments. 

In addition, these machines were unreliable and prone to frequent hardware 

failures. 

5. Second-generation computers used transistors in place of vacuum tubes.  Since 

a transistor is a small device, the physical size of computers was greatly re- 

duced. Computers became smaller, faster, cheaper, energy-efficient and more 

reliable than their predecessors. 

6. Third-generation computers were IC-based machines. The IC replaced sev- 

eral individually wired transistors, making computers smaller in size, reliable 

and efficient. 
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7. Fourth-generation computers use microprocessors (circuits containing mil- 

lions of transistors) as their basic processing device. These computers are 

the most powerful, compact, reliable and affordable as compared to their 

predecessors. 

8. Fifth-generation computers are still in the development stage. These comput- ers 

will use megachips, which will result in the production of microproces- sors 

having millions of electronic components on a single chip. They will use 

intelligent programming (AI) and knowledge-based problem-solving tech- 

niques. 

9. A microcomputer is a small, low-cost digital computer, which usually con- 

sists of a microprocessor, a storage unit, and an input and output channel, all 

of which may be on one chip inserted into one or several PC boards. Micro- 

computers include desktop, laptop and hand-held models, such as PDAs. 

10. A minicomputer is a small digital computer, which normally is able to pro- 

cess and store less data than a mainframe but more than a microcomputer, 

while doing so less rapidly than a mainframe but more rapidly than a micro- 

computer. 

11. A mainframe is an ultrahigh performance computer made for high-volume, 

processor-intensive computing. It is capable of supporting large volumes of 

data processing, high-performance online transaction processing, and exten- 

sive data storage and retrieval. 

12. Supercomputers are the special-purpose machines, which are specifically de- 

signed to maximize the number of FLOPS. Any computer below one gigaflop 

per second is not considered as a supercomputer. 

13. A computer can be viewed as a system that comprises several units (CPU, 

input unit, output unit and storage unit). These individual units work together 
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to convert data into information. 

 
14. The CPU interprets, coordinates the operations and supervises the instruc- 

tions. It has three parts: ALU, CU and registers. The ALU performs arith- 

metic (add, subtract) and logical operations (and, or) on the stored numbers. 

The CU checks the correctness of the sequence of operations, controls the 

I/O devices and directs the overall functioning of the other units of the com- 

puter. The registers are special-purpose, high-speed temporary memory units 

that can hold varied information such as data, instructions, addresses and in- 

termediate results of calculations. 

15. The input unit involves the receipt of data or instructions from the user, in 

a computer acceptable form. The computer takes in the data through input 

devices like keyboard, mouse, light pen, etc. 

16. The output unit supplies the resulting data obtained from the data processing 

to the user. Monitors, printers and plotters are some of the examples of output 

devices. 

17. During processing, the intermediate and the results of processing are held by 

the storage unit until the manipulation of the data is completed. When the 

data to be processed or the results produced by the processing are in large 

volumes, they are stored on various storage media like floppies, hard disks 

and tapes. 

18. A computer performs three basic steps to complete any task: input, process- 

ing and output. A computer receives data as input, processes it, stores it and 

then produces output. 

19. Computers have entered in every sphere of human life and found applications in 

various fields, such as medicine and healthcare, business, education, sci- 

ence, technology, government, entertainment, engineering and architecture. 
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Exercises 
 

Fill in the Blanks 
 

 

1. The basic component of first-generation computers was .................. 

 
2. The speed of a computer is calculated in .................. 

 
3. Third-generation computers were ................... based machines. 

 
4. Keyboard is an ................... device. 

 
5. Laptops are also known as .................. 

 
6. Computers can be classified as .................., .................., ...................... and 

.................. computers. 

 
7. A computer performs three basic steps to complete any task, which are ................... , 

.................. and .................. 

 
8. PDA stands for ................................................... 

 
9. The CPU consists of .................., .................. and .................. 

 
10. Physical components on which the data are stored permanently are called 

.................. 

 

Multiple-choice Questions 
 

 

1. The development of computers can be divided ............. into generations. 

 
(a) 3 

(b) 4 

(c) 5 

(d) 6 
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2. Choose the odd one out. 

 
(a) Microcomputer 

(b) Minicomputer 

(c) Supercomputer 

(d) Digital computer 

 
3. is a very small computer that can be held in the palm of the hand. 

 
(a) PDA 

(b) PC 

(c) Laptop 

(d) Minicomputer computer 

 
4. Analytical engine was developed by .................. 

 
(a) Gottfried Wilhem Von Leibriz 

(b) Charles Babbage 

(c) Charles Babbage 

(d) Joseph-Marie Jacquard 

 
5. The main distinguishing feature of fifth-generation computers will be .................. 

 
(a) Liberal use of microprocessors 

(b) Artificial Intelligence 

(c) Extremely low cost 

(d) Versatility 

 
6. The computer that is not considered as a portable computer is .................. 

 
(a) Laptop 

(b) PDA 
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(c) Minicomputer 

(d) None of these 

 
7. The CPU stands for .................. 

 
(a) Central protection unit 

(b) Central processing unit 

(c) Central power unit 

(d) Central prerogative unit 

 
8. UNIVAC is an example of .................. 

 
(a) First-generation computer 

(b) Second-generation computer 

(c) Third-generation computer 

(d) Fourth-generation computer 

 
9. The unit that performs the arithmetic and logical operations on the stored 

numbers is known as .................. 

(a) Arithmetic logic unit 

(b) Control unit 

(c) Memory unit 

(d) Both (a) and (b) 

 
10. The ................... is the administrative section of the computer system. 

 
(a) Input unit 

(b) Output unit 

(c) Memory unit 

(d) Central processing unit 
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State True or False 
 

 
1. The ALU is responsible for performing the arithmetic and logical operations. 

 
2. Microcomputers are more powerful than minicomputers. 

 
3. Laptop is also known as a notebook. 

 
4. Vacuum tubes were a part of third-generation computers. 

 
5. EDVAC was a second-generation computer. 

 
6. LSI and VLSI technology are part of fifth-generation computers. 

 
7. A laptop is a portable computer. 

 
8. Primary memory and main memory are synonyms. 

 
9. Computer development is divided into four main generations. 

 
10. PARAM is an example of a portable computer. 

 

Descriptive Questions 
 

 
1. Discuss the characteristics of computers. 

 
2. What are the advantages of transistors over vacuum tubes? 

 
3. Discuss various types of computers in detail. 

 
4. List out various applications of computers. 

 
5. Discuss various computer generations along with the key characteristics of 

the computers of each generation. 

6. Discuss the basic organization of a computer system and explain the func- 

tions of various units of a computer system. 
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Chapter 2 

 
Input Output Media 

 
This chapter deals with two basic computer unitsinput and output devices. Input 

devices are used to enter the data and instructions into the computer system before 

any processing can be performed. Output devices are used for the conversion of 

machine-readable information into human-readable form. The chapter discusses 

some commonly used input devices including keyboard, mouse, joystick, scan- 

ner, and optical scanners. The functions of all these input devices along with the 

hard copy and soft copy output devices under which, various types of printers and 

plotters have been explored. Next display devices such as CRT monitors, LCD 

monitors and speech synthesisers are explained. The chapter concludes by giving 

an overview of computer terminals. 

 

2.1 Introduction 

 
Previously, we discussed that a computer accepts input and processes it to get 

a desired output according to the sequence of instructions. Essentially, a com- 

puter system consists of four components: input devices, CPU, output devices and 

memory. Input devices are used to provide data to the CPU for processing. After 
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processing, the input data is converted into meaningful information and this output 

is presented to the user with the help of output devices. In computer terminology, 

a device can be referred to as a unit of hardware, which is capable of providing 

input to the computer or receiving output, or both. 

An input device is an electromechanical device that allows the user to feed in- 

formation into the computer for analysis, storage and to give commands to the 

computer. Data and instructions are entered into the computer’s memory through 

an input device. It captures information and translates it into a form that can be 

processed and used by the other parts of the computer. After processing the in- put 

data, the computer provides the results with the help of output devices. An output 

device converts machine-readable information into human-readable form. The 

basic functioning of the output device is just the opposite of the input device, that 

is, the data is “fed into” the computer system through the input device while the 

output is “taken out” from the computer through the output device. However, the 

output, which comes out from the CPU, is in the form of digital signals (see Figure 

2.1). The output devices display the processed information by converting them 

into graphical, alphanumeric, or audio-visual form. 

Figure 2.1: Data Processing 

 

 
2.1.1 Importance of Input/Output Devices 

 
As we know, the processing of the data by the computer system can be viewed as 

a three-step process: 

• Step 1: Data input via an input device. 
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• Step 2: Processing of data. 

 
• Step 3: Data output via an output device. 

 
Input devices play a major role in the processing of any data via the computer 

system because the output of the computer is always based on the given input. 

Generally, data that is given to the input devices is raw. Therefore, it is the function of 

the input devices to manipulate the raw data and then send them for further 

processing. The preparation of the computerized input is the initial step in the 

creation of useful output. This output must be supplied to the outside world, which 

is done through output devices. 

 

2.2 Types of Input Devices 

 
Computer accepts input in two ways, either manually or directly. In case of manual 

data entry, the user enters the data into computer by hand, for example, by using 

keyboard and mouse. A user can also enter data directly by transferring infor- 

mation automatically from a source document (like from a cheque using MICR) 

into the computer. The user does not need to enter information manually. Direct 

data entry is accomplished by using special direct data entry devices like a barcode 

reader. Some of the commonly used input devices are keyboard, pointing devices 

like mouse and joystick, speech recognition, digital camera and scanners. 

 
2.2.1 Keyboard 

 
A keyboard is the most common data entry device. Using a keyboard, the user can 

type text and commands. The keyboard is designed to resemble a regular 

typewriter with a few additional keys (see Figure 2.2). Data is entered into the 

computer by simply pressing keys. The layout of the keyboard has changed very 

little since it was introduced. In fact, the most common change in its technology 
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has simply been the natural evolution of adding more keys that provide additional 

functionality. The number of keys on a typical keyboard varies from 84 to 104. 

 
 
 

Figure 2.2: Keyboard 

 
 

Portable computers such as laptops quite often have custom keyboards that have 

slightly different key arrangements than a standard keyboard. In addition, many 

system manufacturers add special buttons to the standard layout. A keyboard is the 

easiest input device, as it does not require any special skill. Usually, it is supplied 

with a computer so no additional cost is incurred. The maintenance and operational 

cost of a keyboard is also less. However, using a keyboard for data entry may be a 

slow process because the user has to manually type all the text. In addition, it can 

be difficult for people suffering from muscular disorders. 

 
2.2.2 Pointing Devices 

 
Most computers come with an alphanumeric keyboard but in some applications, 

the keyboard is not convenient. For example, if the user wants to select an item 

Qwerty Query 

 

The layout of a keyboard comes in various styles, such as QWERTY, AZERTY and 

DVORAK. QWERTY is the most common layout in English language computer 

keyboards. It takes its name from the first six letters shown on the keyboard’s top 

row of letters. Similarly, French language keyboards use A and Z in place of Q 

and W and are known as AZERTY keyboards. 
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from a list, the user can identify that item’s position by selecting it through the 

keyboard. However, this action could be performed quickly by pointing at the 

correct position. A pointing device is used to communicate with the computer by 

pointing to locations on the monitor screen. Such devices do not require keying of 

characters; instead the user can move a cursor on the screen and perform move, 

click, or drag operations. Some of the commonly used pointing devices are mouse, 

trackball, joystick, light pen, touch screen and trackpad. 

Mouse: A Mouse is a small handheld pointing device with a rubber ball embed- 

ded at its lower side and buttons on the top. Usually, a mouse contains two or three 

buttons, which can be used to input commands or information (see Figure 2.3). It 

may be classified as a mechanical mouse or an optical mouse, based on the 

technology it uses. A mechanical mouse uses a rubber ball at the bottom surface, 

which rotates as the mouse is moved along a flat surface, to move the cursor. It is 

the most common and least expensive pointing device. An optical mouse uses a 

light beam instead of a rotating ball to detect movement across a specially pat- 

terned mouse pad. As the user rolls the mouse on a flat surface, the cursor on the 

screen also moves in the direction of the mouse’s movement. It is pricier than their 

mechanical counterparts but are accurate and often do not need a mouse pad. 

Figure 2.3: Mouse 

 
 

A mouse allows us to create graphic elements on the screen such as lines, curves 

and freehand shapes. Since it is an intuitive device, it is easier and convenient to 

work as compared to the keyboard. Like a keyboard, it is also supplied with a 

computer; therefore, no additional cost is incurred. However, it needs a flat space 

close to the computer. The mouse cannot easily be used with laptop (notebook) or 
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palmtop computers. These types of computers need a trackball or a touch sensitive 

pad called a touchpad. 

Trackball: A Trackball is another pointing device that resembles a ball nestled in 

a square cradle and serves as an alternative to a mouse. In general, a trackball is 

as if a mouse is turned upside down (see Figure 2.4). It has a ball, which can be 

rotated by fingers in any direction, the cursor moves accordingly. The size of the 

ball in the trackball varies from as large as a cue ball, to as small as a marble. Since 

it is a static device, instead of rolling the mouse on the top of the table the ball on 

the top is moved by using fingers, thumbs and palms. This pointing device comes 

in various shapes and forms but with the same functions. The three shapes, which 

are commonly used are a ball, button and square. 

Figure 2.4: Trackball 

 
 

Joystick: A joystick is a device that moves in all directions and controls the move- 

ment of the cursor. The basic design of a joystick consists of a stick that is attached 

to a plastic base with a flexible rubber sheath. This plastic base houses a circuit 

board that sits beneath the stick. The electronic circuitry measures the movement 

of the stick from its central position and sends the information for processing. A 

joystick also consists of buttons which can be programmed to indicate certain ac- 

tions once a position on the screen has been selected using stick (see Figure 2.5). 

It offers three Joystick types of control: digital, glide and direct. Digital control al- 

lows movement in a limited number of directions such as up, down, left and right. 

Glide and direct control allow movements in all directions (360). Direct control 

joysticks have the added ability to respond to the distance and speed with which 
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the user moves the stick. 
 

Figure 2.5: Joystick 

 
 

Light Pen: A light pen (sometimes called mouse pen) is a hand-held electro- 

optical pointing device which a when touched to or aimed closely at a connected 

computer monitor, will allow the computer to determine where on that screen the 

pen is aimed. It facilitates drawing images and selects objects on the display screen by 

directly pointing to the objects. It is a pen-like device, which is connected to the 

machine by a cable (see Figure 4.10). Although named light pen, it actually does 

not emit light but its light-sensitive diode would sense the light coming from the 

screen. The light coming from the screen causes the photocell Figure 2.6 Light Pen 

to respond by generating a pulse. This electric response is transmitted to the 

processor that identifies the position to which the light pen is pointing. With the 

movement of light pen over the screen, the lines or images are drawn. 

Figure 2.6: Light Pen 

 
 

Light pens give the user the full range of mouse capabilities without the use of a 

pad or any horizontal surface. Using light pens, users can interact more easily with 
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applications, in such modes as drag and drop, or highlighting. It is used directly 

on the monitor screen and it does not require any special hand-eye coordinating 

skills. Pushing the light pen tip against the screen activates a switch, which allows 

the user to make menu selections, draw and perform other input functions. Light 

pens are perfect for applications where desk space is limited, in harsh workplace 

environments, and any situation where fast accurate input is desired. It is very use- 

ful to identify a specific location on the screen. However, it does not provide any 

information when held over a blank part of the screen. A light pen is economically 

priced and requires little or no maintenance. 

Touch Screen: A touch screen is a special kind of input device that allows the 

direct selection of a menu item or the desired icon with the touch of finger (see 

Figure 2.7). Essentially, it registers the input when a finger or other object is 

touched to the screen. It is normally used when information has to be accessed 

with minimum effort. However, it is not suitable for input of large amounts of 

data. Typically, it is used in information-providing systems like hospitals, airlines 

and railway reservation counters, amusement parks, and so on. 

Figure 2.7: Touch Screen 

 
 

The controller connects the touch sensor and the computer. It takes information 

from the touch sensor and translates it into information that a computer can un- 

derstand. The driver is a software update for the computer system that allows the 

touch screen and computer to work together. It tells the operating system how to 
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interpret the touch event information that is sent from the controller. 

 
Trackpad: Trackpad (also referred to as touchpad) is a stationary pointing device 

that works by sensing the movement of fingers across a small sensitive surface 

(1.5 or 2 inches) and translating them into the pointer movement on the screen 

(see Figure 2.8). It is generally used in laptops but can also be connected to a PC 

through a cord. It is also equipped in personal digital assistants (PDAs) and media 

players such as the iPod. Typically, a trackpad also consists of two or three buttons 

which work as mouse buttons. Many trackpads are also strike sensitive, that is, the 

user can tap on the trackpad to perform operations like selecting an object, 

maximizing/ minimizing the window, etc. 

Figure 2.8: Trackpad 

 
 

Note: The device manufactured by Apple is referred to as Trackpad while the 

device manufactured by others is known as Touchpad. 

 
2.2.3 Speech Recognition 

 
Speech recognition is one of the most interactive systems to communicate with the 

computer. The user can simply instruct the computer, with the help of a micro- 

phone (along with a speech recognition software), to perform a task (see Figure 

2.9). It is the technology by which sounds, words or phrases spoken by humans 

are converted into digital signals, and these signals are transformed into computer- 
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generated text or commands.  Most speech recognition systems are speaker-dependent 

so they must be separately trained for each individual user. The speech recognition 

system “learns” the voice of the user, who speaks isolated words repeatedly. Then, 

these voiced words are recognizable in the future. 

Figure 2.9: Trackpad 

 
 

Speech recognition is gaining popularity in the corporate world among non-typists, 

people with disabilities, and business travellers who record information for later 

transcription. The computer-based speech-recognition systems can be used to cre- 

ate text documents such as letters or e-mails, to browse the Internet, and to navigate 

among applications by voice commands. They have relatively high accuracy rates. 

They allow the user to communicate with the computer directly without using a 

keyboard or a mouse. However, as compared to other input devices, the reliability 

of the speech recognizer is lesser. Sometimes, it is unable to differentiate between 

two similar sounding words such as see and sea. It is also not suitable for noisy 

places. 

 
2.2.4 Digital Camera 

 
A Digital camera, as shown in Figure 2.10, stores images digitally rather than 

recording them on a film. Once a picture has been taken, it can be transferred 

to a computer system and then manipulated with an image editing software, and 

printed. The big advantage of digital cameras is that making photos is both inex- 

pensive and fast because there is no film processing. 
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Figure 2.10: Digital Camera 
 

 

2.2.5 Webcam 

 
A webcam (short form of web camera) is a portable video camera, which captures 

live video or images that may be viewed in real time over a network or the Inter- 

net. It is just a small digital camera that is either built in your computer (in most 

laptops) or can be connected through a USB port (see Figure 2.11). It is normally 

placed on top of the PC monitor or laptop to capture images of the user while 

he/she is working on the computer. 

Figure 2.11: Webcam 

 
 

Nowadays, a wide variety of webcams are available, and according to their varied 

capabilities and features, they are classified into two categories, namely, streaming 

and snapshot. A streaming webcam captures moving images (about 30 images per 

second), thus creating a streaming videoa web video that plays on the computer 

immediately as its data arrive via network; the recipient need not download the 

video. However, a high-speed Internet connection is needed to transfer the video 

smoothly, and the image quality is also comparatively poor. On the other hand, 

a snapshot webcam captures only still images (usually, once every 30 seconds) 

and refreshes it continuously. It produces better quality images and is easier to 

configure than streaming videos. 
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The popularity of webcams is increasing everyday due to their unlimited uses. The 

most popular use of webcams is in videoconferencing to provide real-time com- 

munication where groups of people can see and interact with each other. It can be 

used with various messenger programs like Yahoo and Windows Live Messenger 

where you can share your videos while instant messaging with somebody. It is 

also being used in educational institutions to conduct distance-learning activities; 

one can attend the classes sitting at home only. 

Webcams are cheap, compact and are easy to install and use. They are affordable 

because of their low manufacturing cost. However, a major drawback of using 

webcams is that they produce only real-time images and cannot be used unless 

attached with the PC. Some webcams also comprise advanced features such as au- 

tomatic lightning controls, automatic face tracking and autofocus, which increase 

their cost. 

 
2.2.6 Scanners 

 
There are a number of situations when some information (picture or text) is avail- 

able on paper and is needed on the computer for further manipulation. A scanner 

is an input device that converts a document into an electronic format that can be 

stored on the disk. The electronic image can be edited, manipulated, combined 

and printed by using the image editing software. Scanners are also called optical 

scanners as they use a light beam to scan the input data. 

Note that most scanners come with a utility program that allow them to commu- 

nicate with the computer and save the scanned images as a graphic files on the 

computer. Moreover, they can store images in both greyscale and colour mode. 

The two most common types of scanners are hand-held scanners and flatbed scan- 

ners. 

Hand-held Scanner: A hand-held scanner consists of LEDs, which are placed 
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over the document to be scanned (see Figure 2.12). This scanner performs the 

scanning of the document very slowly from the top to the bottom with its light on. 

In this process, all the documents are converted and then stored as images. While 

working, the scanner is dragged very steadily and carefully over the document at 

a constant speed without stopping or jerking in order to obtain best results. Hand- 

held scanners are widely used where high accuracy is not of much importance. 

The size of the hand-held scanners is small. They come in various resolutions, up 

to about 800 dpi (dots per inch) and are available in either greyscale or colour. 

Furthermore, they are used when the volume of the documents to be scanned is 

low. These devices read the data on price tags, shipping labels, inventory part 

numbers, book ISBNs and so on. 

Figure 2.12: Hand-held Scanner 

 
 

Flatbed Scanner: A flatbed scanner looks similar to a photocopier machine. It 

consists of a box containing a glass plate on its top and a lid that covers the glass 

plate (see Figure 2.13). This glass plate is used for placing the document to be 

scanned. The light beam is placed below the glass plate and when it is activated, 

it moves horizontally from left to right. After scanning one line, the light beam 

moves in order to scan the next line and the procedure is repeated until all the lines 

are scanned. Scanning an A4 size document takes about 20 seconds. These 

scanners can scan black and white as well as colour images. Flatbed scanners are 

larger in size and more expensive than hand-held scanners. However, they usually 

produce better quality images because they employ better scanning technology. 
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Figure 2.13: Flatbed Scanner 

 
 

Some scanners use a three-pass scanning method. Each pass uses a Working of 

a Flatbed Scanner different colour filter (red, green or blue) between the lens and 

CCD array. After the three passes are completed, the scanner software assembles 

the three filtered images into a single full-colour image. Nowadays, most scanners 

use the single-pass method. The lens splits the image into three smaller versions of 

the original image. Each smaller version passes through a colour filter (either red, 

green or blue) onto a discrete section of the CCD array. The scanner combines the 

data from the three parts of the CCD array into a single full-colour image, which 

is then sent to the computer. 

 
2.2.7 Optical Character Recognition 

 
As stated earlier, a scanner converts an input document into an electronic format 

that can be stored on the disk. If the document to be scanned contains an image, it 

can be manipulated using image editing software. However, if the document to be 

scanned contains text, you need an optical character recognition (OCR) software. 

This is because when the scanner scans a document, the scanned document is 

stored as a bitmap in the computer’s memory. The OCR software translates the 

bitmap image of text to the ASCII codes that the computer can interpret as letters, 

numbers and special characters. 

Because of OCR, data entry becomes easier, error-free and less time consuming. 
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However, it is very expensive and if the document is not typed properly, it will 

become difficult for the OCR to recognize the characters. Furthermore, except for 

tab stops and paragraph marks, most document formatting is lost during text 

scanning. The output from a finished text scan will be a single column editable 

text file. This text file will always require spell checking and proof reading as well 

as re-formatting to get the desired final layout. 

 
2.2.8 Optical Mark Recognition 

 
Optical mark recognition (OMR) is the process of detecting the presence of in- 

tended marked responses. A mark registers significantly less light than the sur- 

rounding paper. Optical mark reading is done by a special device known as optical 

mark reader. In order to be detected by the OMR reader, a mark has to be posi- 

tioned correctly on the paper and should be significantly darker than the surround- 

ing paper. The OMR technology enables a high-speed reading of large quantities 

of data and transferring this data to a computer without using a keyboard. Gen- 

erally, this technology is used to read answer sheets (objective type tests). In this 

method, special printed forms/documents are printed with boxes, which can be 

marked with a dark pencil or ink (see Figure 2.14). These forms are then passed 

under a light source and the presence of dark ink is transformed into electric pulses, 

which are transmitted to the computer. 

Figure 2.14: Questionnaire Using OMR Marks 

 
 

OMR has a better recognition rate than OCR because fewer mistakes are made by 

machines to read marks than in reading handwritten characters. Large volumes of 
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data can be collected quickly and easily without the need for specially trained staff. 

Usually, an OMR reader can maintain a throughput of 1500 to 10,000 forms per 

hour. However, the designing of documents for optical mark recognition is com- 

plicated and the OMR reader needs to be reprogrammed for each new document 

design. OMR readers are relatively slow because the person putting marks on the 

documents must follow the instructions precisely. Any folding or dirt on a form 

may prevent the form from being read correctly. In addition, it requires accurate 

alignment of printing on forms and needs a paper of good quality. 

 
2.2.9 Magnetic-ink Character Recognition 

 
You must have seen special magnetic encoding using characters printed on the 

bottom of a cheque (see Figure 2.15). The characters are printed using special ink, 

which contains iron particles that can be magnetized. To recognize these magnetic 

ink characters, a Magnetic ink character reader (MICR) is used. It reads the 

characters by examining their shapes in a matrix form and the information is then 

passed on to the computer. 

Figure 2.15: Cheque Number Written in MICR Font 

 
 

The banking industry prefers MICR to OCR as MICR gives extra security against 

forgeries such as colour copies of payroll cheques or hand-altered characters on a 

cheque. If a document has been forged, say a counterfeit check produced using a 

colour photocopying machine, the magnetic-ink line will either not respond to 

magnetic fields, or will produce an incorrect code when scanned using a device 
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designed to recover the information in the magnetic characters. The reading speed 

of the MICR is also higher. This method is very efficient and time saving for data 

processing. 

 
2.2.10 Bar Code Reader 

 
Bar code is a machine-readable code in the form of a pattern of parallel vertical 

lines of varying widths. It is commonly used for labelling goods that are avail- 

able in super markets and numbering books in libraries. This code is sensed and 

read by a bar code reader using reflective light (see Figure 2.16). The information 

recorded in the bar code reader is then fed into the computer, which recognizes 

the information from the thickness and spacing of bars. Bar code readers are ei- 

ther hand-held or fixed-mount. Hand-held scanners are used to read bar codes on 

stationary items. With fixed-mount scanners, items having a bar code are passed 

by the scanner by hand, as in retail scanning applications or by conveyor belts in 

many industrial applications. 

Figure 2.16: Bar Code Reader 

 
 

Bar code data correction systems provide enormous benefits for just about every 

business with a bar code data-collection solution; capturing data is faster and more 

accurate. A bar code scanner can record data five to seven times faster than a 

skilled typist. A bar code data entry has an error rate of about 1 in 3 million. Bar 

coding also reduces cost in terms of labour and revenue losses resulting from data 

collection errors. Bar code readers are widely used in supermarkets, department 

stores, libraries and other places. You must have seen bar code on the back cover of 

certain books and greeting cards. Retail and grocery stores use a bar code reader 



Input Output Media 

– Page 49 – 

 

 

to determine the item being sold and to retrieve the item price from a computer 

system. 

Bar code scanners are electro-optical systems that include a means of illuminating 

the symbol and measuring reflected light. The light waveform data are converted 

from analog to digital, in order to be processed by a decoder, and then transmitted 

to the computer software. The process begins when a device directs a light beam 

over a bar code. The device contains a small sensory reading element, called sen- 

sor, which detects the light being reflected back from the bar code, and converts 

light energy into electrical energy. The result is an electrical signal that can be con- 

verted into alphanumeric data. The pen in the bar code unit reads the information 

stored in the bar code and converts it into a series of ASCII characters by which 

the operating system gets the information stored in the bar code. 

 

2.3 Types of Output Devices 

 
Output is data that have been processed into useful information. It can be displayed 

or viewed on a monitor, printed on a printer, or listened through speakers or a head- 

set. Generally, there are two basic categories of output: the output which can be 

readily understood and used by humans, and which is stored on secondary storage 

devices so that the data can be used as input for further processing. The output 

which can be easily understood and used by human beings are of the following 

two forms: 

• Hard Copy: The physical form of output is known as hard copy. In general, 

it refers to the recorded information copied from a computer onto paper or 

some other durable surface such as microfilm. Hard copy output is perma- 

nent and a relatively stable form of output. This type of output is also highly 

portable. Paper is one of the most widely used hard copy output media. The 

principal examples are printouts, whether text or graphics from printers. 
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• Soft Copy: The electronic version of an output, which usually resides in 

computer memory and/or on disk, is known as soft copy. Unlike hard copy, 

soft copy is not a permanent form of output. It is transient and is usually 

displayed on the screen. This kind of output is not tangible, that is, it cannot 

be touched. Soft copy output includes audio and visual form of output, which is 

generated using a computer. In addition, textual or graphical information 

displayed on a computer monitor is also a soft copy form of output. 

 
Based on the hard copy and soft copy outputs, the output devices are classified into 

hard copy and soft copy output devices. Printers, plotters and microfilms are the 

most commonly used hard copy output devices while monitors, voice response sys- 

tems, projectors, electronic whiteboards, and headphones and headsets are some 

commonly used soft copy output devices. 

 
2.3.1 Printers 

 
Ever since the dawn of computer age, producing printed output on paper has been 

one of the computer’s principal functions. A printer prints information and data 

from the computer onto paper. Generally, the printer prints 80 or l32 columns of 

characters in each line, and prints either on single sheets or on a continuous roll 

of paper, depending upon the printer itself. The quality of a printer is determined 

by the clarity of a print it can produce, that is, its resolution. Resolution is used to 

describe the sharpness and clarity of an image. The higher the resolution, the better 

the image. For printers, the resolution is measured in dpi (dots per inch). The more 

the dpi, the better will be the quality of image. The dots are so small and close 

together that they project the image as a solid one. If a printer has a resolution of 

600 dpi, it means that the printer is capable of printing 360,000 dots per square 

inch. 

Printers are divided into two basic categories: impact printers and non-impact 
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printers. As their names specify, impact printers work by physically striking a 

head or needle against an ink ribbon to make a mark on the paper. This includes 

dot matrix printers, daisy wheel printers and drum printers. In contrast, ink-jet and 

laser printers are non-impact printers. They use techniques other than physically 

striking the page to transfer ink onto the page. 

Dot Matrix Printer: Dot matrix printer (also known as the wire matrix printer) 

uses the oldest printing technology and it prints one character at a time (see Figure 

2.17). It prints characters and images as pattern of dots. The speed of dot matrix 

printers is measured in characters per second (cps). Most dot matrix printers offer 

different speeds depending on the quality of print desired. The speed can vary 

from about 200 to over 500 cps. The print quality is determined by the number of 

pins (the mechanisms that print the dots), which can vary from 9 to 24. The more 

pins per inch, the Figure 2.17 Dot Matrix higher the print resolution. The best dot 

matrix printers Printer (24 pins) can produce near letter-quality-type image. Most 

dot matrix printers have a resolution ranging from 72 to 360 dpi. 

Figure 2.17: Dot Matirx Printer 

 
 

Dot matrix printers are inexpensive and have low operating costs. These printers 

are able to use different types of fonts, different line densities and different types 

of paper. Many dot matrix printers are bi-directional, that is, they can print the 

characters from either direction– left or right. The major limitation of the dot ma- 

trix printer is that it prints only in black and white. In addition, as compared to 

printers like laser printers, they produce low to medium quality printing. The im- 

age printing ability is also very limited. These printers may not be able to print 

graphic objects adequately but can handle applications such as accounting, per- 
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sonnel and payroll very well. Dot matrix printers are commonly used in low-cost, 

low-quality applications like cash registers. These printers are limited to situations 

where carbon copies are needed and the quality is not too important. 

Daisy Wheel Printer: The major drawback of the dot matrix printer is that the 

pattern of dots that make up each character is visible on the print produced by it, 

making it look unprofessional. If you need a printer that can produce professional 

letter quality documents, you need a daisy wheel printer. The daisy wheel printer 

is named so because the print head of this printer resembles a daisy flower, with 

printing arms that appear like the petals of the flower (see Figure 2.18). These 

printers are commonly referred to as letter quality printers as the print quality is as 

good as that of a high-quality typewriter. 

Figure 2.18: Daisy Wheel Printer 

 
 

Daisy wheel printers produce high-resolution output and are more reliable than 

dot matrix printers. They can have speeds up to 90 cps. These printers are also 

called smart printers because of their bi-directional printing and built-in micro- 

processor control features. However, daisy wheel printers give only alphanumeric 

output. They cannot print graphics and cannot change fonts unless the print wheel 

is physically replaced. These printers are usually very slow because of the time re- 

quired to rotate the print wheel for each character desired. Daisy wheel printers are 

slower and more expensive than dot matrix printers. However, if the appearance 

of the correspondence is important and you do not need graphics, a daisy wheel 

printer is a better choice. 

Drum Printer: The dot matrix and daisy wheel printers are character or serial 

printers, that is, they print one character at a time. However, a drum printer (shown 
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in Figure 2.19) is a line printer, that is, it can print a line in a single operation. Gen- 

erally, a line printer is used because of its speed as it uses special tractor-fed paper 

with pre-punched holes along each side. This arrangement allows a continuous 

high-speed printing. Its printing speed varies from 300 lines to 2000 lines per 

minute with 96160 characters on a 15-inch line. Although such printers are much 

faster than character printers, they tend to be quite loud, have limited multi-font 

capability and often produce lower print quality than most recent printing tech- 

nologies. Line printers are designed for heavy printing applications. For example, 

in businesses where enormous amounts of materials are printed, the low-speed 

character printers are very slow; therefore, the users need high-speed line print- 

ers. Although, drum printers have high speed of printing, they are very expensive 

and their character fonts cannot be changed. Moreover, the strike of the hammer 

should be precise. A single mistimed strike of the hammer may lead to wavy and 

slightly blurred printing. 

Figure 2.19: Drum Printer 

 
 

Ink-jet Printer: The most common type of printer found in homes today is the 

ink-jet printer (see Figure 2.20). An ink-jet printer is a printer that places ex- 

tremely small droplets of ink onto paper to create an image. Being a non-impact 

printer, it does not touch the paper while creating an image. Instead, it uses a series 

of nozzles to spray drops of ink directly onto the paper. Inkjets were origi- nally 

manufactured to print in monochrome (black and white) only. However, the print 

head has now been expanded and the nozzles increased to accommodate cyan (C), 

magenta (M), yellow (Y) and black (K). This combination of colours is called 
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CMYK. It allows for printing images with nearly Figure 2.20 Ink-jet Printer the 

same quality as a photo development lab using certain types of coated paper. 

Figure 2.20: Ink-Jet Printer 

 
 

Ink-jet printers are costlier than dot matrix printers and the quality is much better. 

These printers can print any shape of character, which a user can specify, as they 

produce printed output as patterns of tiny dots. This allows the printer to print 

many special characters, different sizes of prints, and enables it to print graphics 

such as charts and graphs. Ink-jet printers typically print with a resolution of 600 

dpi or more. Due to the high resolution, these printers produce high quality graph- 

ics and text printouts. They are also affordable, which appeals to small businesses 

and home offices. These printers print documents at a medium pace but slow down 

if printing a document with multi-colours. These printers can print about six pages 

a minute and can be programmed to print symbols such as Japanese or Chinese 

characters. 

Laser Printer: A laser printer provides the highest quality text and images for 

personal computers today (see Figure 2.21). It is a very fast printer, which operates 

on the same principle as that of a photocopy machine. Most laser printers can print 

text and graphics with a very high quality resolution. They are also known as page 

printers because they process and store the entire page before they actually print 

it. They produce sharp, crisp images of both text and graphics, providing 

resolutions from 300 to 2400 dpi. Today, the resolution of most printers is 600 

dpi.   They are quiet and fast, are able to print 4-32 text-only pages per minute for 

individual microcomputers and up to 200 pages per minute for mainframes. 
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Laser printers can print in excess of 2000 lines per minute. Furthermore, they can 

print in different fonts, that is, type styles and sizes. Laser printers are often faster 

than ink-jet printers but are more expensive to buy and maintain than the other 

printers. The cost of these printers depends on a combination of costs of paper, 

toner replacement, and drum replacement. These printers are useful for volume 

printing because of their speed. 

Figure 2.21: Laser Printer 

 
 

Hydra Printer: Hybrid document reproduction apparatus (HYDRA) printer, pop- 

ularly known as all-in-one printer, is a device that consolidates the capabilities of 

multiple devices in one machine (see Figure 2.22). It may include some or all of 

the devices like printer, scanner, photocopier and fax machine. Apart from these 

devices, some hydra printers contain memory card slots which facilitate easier 

printing of photos and also have the in-built wireless capabilities that make Hydra 

Printer sharing of this printer with other systems easier. 

Figure 2.22: Hydra Printer 

 
 

Following are the features that must be considered to evaluate these printers: 

 
• Print speed 
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• Maximum resolution 

 
• Memory card compatibility 

 
• Scanner resolution 

 
• Fax speed 

 

Hydra printers are useful for small organizations due to their small size, less space 

requirement and cost effectiveness. The cost of these printers depend on the tech- 

nology (inkjet or laser) being used. They save power to a great extent as only one 

power outlet is required for performing various operations. They are easy to install 

and maintain and have easy-to-use GUI (graphical user interface) that help users 

to understand their functions easily. 

 
2.3.2 Plotters 

 
A plotter is a pen-based output device that is attached to a computer for making 

vector graphics, that is, images created by a series of many straight lines. It is used 

to draw high-resolution charts, graphs, blueprints, maps, circuit diagrams and other 

line-based diagrams. It is similar to a printer, but it draws lines using a pen. As a 

result, it can produce continuous lines, whereas a printer can only simulate lines by 

printing a closely spaced series of dots. Multicolour plotter uses different coloured 

pens to draw different colours. Colour plots can be made by using four pens (cyan, 

magenta, yellow and black) and need no human intervention to change them. 

Being vector-based, a plotter tends to draw much crisper lines and graphics. The 

lines drawn by these devices are continuous and very accurate. However, the 

plotter is considered a very slow output device because it requires excessive me- 

chanical movement to plot. Furthermore, it is unable to produce solid fills and 

shading. Plotters are relatively expensive as compared to printers but can produce 

more printouts than standard printers. They are mainly used for Computer Aided 
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Design (CAD) and Computer Aided Manufacturing (CAM) applications such as 

printing out plans for houses or car parts. These are also used with programs like 

AUTOCAD (computer assisted drafting) to give graphic outputs. As shown in Fig- 

ure 2.23, there are two different types of plotters: drum plotter (where the paper 

moves) and flatbed plotter (where the paper is stationary). 

Figure 2.23: Plotters 

 

 
• Drum Plotter: In drum plotters, the paper on which the design is to be 

printed is placed over a drum. These plotters consist of one or more pen(s) 

that are mounted on a carriage which is horizontally placed across the drum. 

The drum can rotate in either clockwise or anticlockwise direction under the 

control of plotting instructions sent by the computer. In case a horizontal 

line is to be drawn, the horizontal movement of the pen is combined with the 

vertical movement of the page via the drum. The curves can also be drawn 

by creating a sequence of very short straight lines. In these plotters, each pen 

can have an ink of a different colour to produce multicolour designs. Drum 

plotters are used to produce continuous output such as plotting earthquake 

activity or for long graphic output such as tall building structures. 

• Flatbed Plotter: Flatbed plotters consist of a stationary, horizontal plotting 

surface on which paper is fixed. The pen is mounted on a carriage, which can 

move horizontally, vertically, leftwards or rightwards to draw lines. In flatbed 

plotters, the paper does not move, the pen-holding mechanism provides all 

the motion. These plotters are instructed by the computer on the movement 

of pens in the x - y coordinates on the page. These plotters are capable of 
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working on any standard, that is, from A4 size paper to some very big beds. 

Depending on the size of the flatbed surface, these are used in designing of 

ships, aircrafts, buildings and so on. The major disadvantage of this plotter 

is that it is a slow output device and can take hours to complete a complex 

drawing. 

 
2.3.3 Monitor 

 
The monitor is the most frequently used output device for producing soft-copy 

output. A computer monitor is a TV-like display attached to the computer on 

which the output can be displayed and viewed. The computer monitor can either 

be a monochrome display or a colour display. A monochrome screen uses only 

one colour (usually white, green, amber or black) to display text on contrasting 

background. Colour screens commonly display 256 colours at one time from a 

selection of over 256,000 choices. Monitors are available in various sizes like 14, 

15, 17, 19 and 21 inches. The size of the display is described based on two 

parameters: aspect ratio and screen size (see Figure 2.24). Aspect ratio is the ratio 

of the width of the display screen to the height, that is, the ratio of vertical points 

to the horizontal points necessary to produce equal-length lines in both directions 

on the screen. Generally, computer displays have an aspect ratio of 4:3. Like 

televisions, screen sizes are normally measured diagonally (in inches), the distance 

from one corner to the opposite corner. 

Figure 2.24: Aspect Ratio and Screen Size 

 
 

Sometimes, while watching television, you may notice that the picture looks a bit 

blurred. The reason behind this is that the displayed image is not solid but is 
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created by the configurations of dots. These dots are known as picture elements, 

pels, or simply pixels. The golden rule of a sharp image is that the more the pixels, 

the sharper the picture. The screen clarity depends on three basic qualities: 

• Resolution: It refers to the number of pixels in the horizontal and vertical 

directions on the screen. In medium-resolution graphics, pixels are large, 

whereas in high-resolution graphics, pixels are small. The average CRT dis- 

play is currently 800 600 or 1024 768. The more dots, or pixels, available 

to create the image, the sharper it will be. Therefore, a resolution of 1024 

768 will produce sharper images (for example, smaller icons and more infor- 

mation) than one of 640 480. 

• Dot Pitch: It is the measurement of the diagonal distance between two like- 

coloured (red, green or blue) pixels on a display screen. It is measured in 

millimetres and common dot pitches are .51 mm, .31 mm, Pixel .28 mm, .27 

mm, .26 mm and .25 mm. The Figure 4.44 Dot Pitch smaller the dot pitch, 

the sharper will be the image when displayed on the monitor. Generally, a dot 

pitch of less than .31 mm provides clear images. Multimedia and desktop- 

publishing users typically use .25 mm dot-pitch monitors (see Figure 2.25). 

 

Figure 2.25: Dot Pitch 

 
 

• Refresh Rate: It is the number of times per second the pixels are recharged 

so that their glow remains bright. Normally, screen pixels are made from 

phosphor. An electron beam strikes the phosphor and causes it to emit light, 

resulting in the display of the image. However, it needs to be Refreshed 
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periodically because the phosphors hold their glow for just a fraction of a 

second. The Refresh rate for a monitor is measured in Hertz (Hz) and varies 

from 60 to 75 Hz. A Refresh rate of 60 Hz means image is redrawn 60 times 

a second. The higher the Refresh rate, the more solid the image looks on the 

screen, that is, it does not flicker. 

 
Colour Depth: Colour depth, also referred to as bit depth, refers to the number of 

bits assigned to each pixel in the image and the number of colours that can be 

created from those bits. In simple words, it refers to the number of colours that 

a monitor can display. Different colour depths depend on the amount of display 

memory dedicated to each pixel. One byte is used to represent 256 colours for 

each pixel, 16 bits (or 2 bytes) per pixel allows up to 65535 colours, and 24-bit (or 

3 bytes) colour can display 16.8 million different colours per pixel. 8-bit colour 

is better known as pseudo colour, 16-bit mode as high colour, and 24-bit mode is 

called true colour. A video display unit consists of a video card or adapter that is 

fitted into an expansion slot and a compatible visual display, which is compatible 

with the video adapter. The combination of the display modes supported by the 

graphics adapter and the colour capability of the monitor determine how many 

colours can be displayed. 

Cathode Ray Tube Monitors: Nowadays, most computer monitors are based on 

cathode ray ube (CRT ) technology. The basic operation of these tubes is similar 

to that in television sets. Figure 2.26 illustrates the basic components of a CRT. 

Figure 2.26: Cathode Ray Tube 
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A beam of electrons (cathode rays) emitted by an electron gun passes through 

focusing and deflection systems that direct the beam toward specified positions on 

the phosphor-coated screen. The phosphor then emits a small spot of light at each 

position contacted by the beam. When the electron beam strikes the phosphors, the 

light is emitted for a short period of time, this condition is known as persistence. 

Technically, persistence is defined as the time it takes for the emitted light from 

the screen to decay to 1/10 of its original intensity. Graphics monitors are usually 

constructed with persistence in the range of 10-60 microseconds. Since the light 

emitted by the phosphor fades very rapidly, some method is needed for maintaining 

the screen picture. One way to keep the phosphor glowing is to redraw the picture 

repeatedly by quickly directing the electron beam back over the same points. This 

type of display is called a Refresh CRT. 

Liquid Crystal Display Monitors: In the previous section, we discussed the most 

popular CRT monitors that are used as display devices. With the widespread use 

of smaller computers like PDAs and laptops, a new type of display, Liquid Crystal 

Display (LCD), has made a big impact on the computer market. LCD screens have 

been used for long on notebook computers but are also becoming popular as 

desktop monitors. 

The term liquid crystal sounds like a contradiction. We generally conceive a crystal as 

a solid material like quartz and a liquid as water-like fluid. However, some sub- 

stances can exist in an odd state that is semi-liquid and semi-solid. When they are 

in this state, their molecules tend to maintain their orientation like the molecules 

in a solid, but also move around to different positions like the molecules in a liq- 

uid. Thus, liquid crystals are neither a solid nor a liquid. Manufacturers use this 

amazing ability of liquid crystals to display images. 

An LCD screen is a collection of multiple layers as shown in Figure 2.27. A flu- 

orescent light source, known as the backlight, makes up the rearmost layer. Light 

passes through the first of two polarizing filters. The polarized light then passes 
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through a layer that contains thousands of liquid crystal blobs aligned in tiny con- 

tainers called cells. These cells are aligned in rows across the Figure 2.27 Coloured 

Liquid Crystal Screen screen; one or more cells make up one pixel. Electric leads 

around the edge of the LCD create an electric field that twists the crystal molecule, 

which lines the light up with the second polarizing filter and allows it to pass 

through. 

Figure 2.27: Coloured Liquid Crystal Screen 

 
 

Differences between LCD and CRT: Although both the CRT and LCD monitors 

are the most frequently used types of displays in computers, they are worlds apart 

in terms of what is important when making a purchase decision. Here is a brief 

discussion of what is different about LCD monitors. 

• Size: LCD is lightweight and compact, which saves desktop space as com- 

pared to a CRT. 

• Resolution: LCD is designed to work in a single resolution while CRT is 

designed for many resolutions. 

• Pixel Density: Pixel density of LCD is generally not as tight as the dot pitch 

in CRT but for most applications, the density is acceptable. 

• Brightness: The illuminated phosphor of a CRT is not nearly as bright as 

what the LCD can produce with its florescent backlight. 

• Power Consumption: LCD consumes significantly less power than CRT 
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and has a low emission risk. Typically, a LCD consumes approximately half 

of the power of a typical CRT. 

• Flicker: With CRT monitors, the goal is to get a faster Refresh rate of at least 85 

Hz,but LCD monitors are designed to run at a much slower Refresh rate 

(usually about 60 Hz) and flicker is never an issue. 

• Pixel Response Time: The time taken by a pixel to change its state is called 

pixel response time. CRT has extremely fast pixel response time but LCD 

can be quite slow. As a result, the user might see ghost images when there 

is movement on the screen. The fastest LCD monitors today have a response 

time of 25 milliseconds, which is still only about half the speed of a CRT 

monitor. 

• Viewing Angle: CRT can be viewed at almost any angle but LCD is best 

viewed head on. Even when viewing an LCD head on, narrow viewing angles 

can appear to have inconsistent colour and brightness. 

• Viewing Area: The viewing area of a CRT is usually less than its advertised 

area. Most 19-inch CRT monitors, for example, typically have about 18 

inches of viewable area. However, the LCD monitors are measured exactly, 

that is, if a LCD monitor is advertised as 17.4 inch, it is the same. 

• Cost: Prices for LCD screens are quite high but they are coming down. They are 

still much more costlier than CRT. 

 
2.3.4 Voice Response System 

 
Previously, we discussed that voice (in speech recognition) can be taken as an input 

by the computer system. Similarly, the computer can also give output in the form 

of audio. Voice response system has an audio-response device which produces 

audio output. These sounds are pre-recorded in a computer system. Each sound 
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has a unique code. Whenever an enquiry is sought from the system, the computer 

responds in digital form which is sent to voice devices that unscramble the digital 

information and produces sound messages to the requesting computer. 

There are two basic approaches to get a computer to talk to the user. The first is 

synthesis by analysis, in which the device analyses the input of an actual human 

voice speaking words, stores and processes the spoken sounds, and reproduce them 

as needed. The process of storing words is similar to the digitizing process we 

discussed while considering voice input. In essence, synthesis by analysis uses the 

computer as a digital tape recorder. The second approach to synthesizing speech 

is synthesis by rule, in which the device applies a complex set of linguistic rules to 

create artificial speech. Synthesis based on the human voice has the advantage of 

sounding more natural but is limited to the number of words stored in the computer. 

The standard computer system can provide audio output with the addition of two 

components: a speech synthesizer that does the speaking and a screen reading 

software that tells the synthesizer what to say (see Figure 2.28). The synthesizer 

can be a computer card inserted into the computer or software that works with the 

computer’s sound card. Screen reader is a software program that allows the user to 

control the synthesizer so that he can access text, which is displayed on the com- 

puter monitor, with combinations of keystrokes. Some screen review softwares 

use the standard computer keyboard keys, some use the numeric keypad, and some 

use special external keypads. A visually impaired user can use a screen reader to 

read anything on the screen. The screen reading software can even notify a user 

about various computer messages that “pop up” on the monitor from time to time. 

Figure 2.28: Audio Output 

 
 

Voice output has become common in many places like airlines, bus terminals, 
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banks and brokerage houses. It is typically used when an inquiry is followed 

by a short reply (such as a bank balance or flight time). Many businesses have 

found other creative uses for voice output. For example, the telephone. Automatic 

telephone voices take surveys, inform customers that catalogue orders are ready 

to be picked up, and perhaps remind consumers that they have not paid their bills. 

Moreover, people with a total or partial speech handicap are faced with the prob- 

lem of communicating their wishes and needs to others. Speech output systems 

are a valuable aid in this case. 

 
2.3.5 Electronic Whiteboard 

 
Electronic whiteboard is an interactive presentation device that works electroni- 

cally to display digital images, drawings and text in different colours. The white- 

board is generally mounted on the wall and is connected to a computer (through 

USB, serial port or wireless technology like Bluetooth) and projector. The projec- 

tor projects the computer’s desktop on the whiteboard and user can interact with 

it using electromagnetic pens, fingers or other pointing devices (see Figure 2.29). 

The electromagnetic pens can be configured to any Figure 2.29 Electronic White- 

board colour or width. 

Figure 2.29: Electronic Whiteboard 

 
 

A user can activate programs, applications and menus as well as enter text using 

either the on-screen keyboard or handwriting recognition utility. Nowadays, most 

whiteboards come with software that provides various tools and features to create 
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virtual versions of paper flipcharts with pen, highlighter, etc., enhancing the use of 

electronic whiteboard to a great extent. Electronic whiteboard is widely used for 

various purposes such as to display presentations, for teaching in classrooms, in 

corporate meetings, professional sports coaching and so on. 

An interactive electronic whiteboard can be classified into one of the following 

categories: 

• Touch-based Whiteboard 

 
• Pen-based Whiteboard 

 
• Wii Remote, IR Pen-based Whiteboard 

 

Note: The device driver software installed on the computer enables the whiteboard to 

act as a human input device (HID), just like a mouse, to help the user with easy 

interaction. 

 
2.3.6 Headphone and Headset 

 
Headphone is an audio device equipped with a pair of speakers attached to a head- 

strap worn by the users. Headphones are used with almost all electronic devices 

such as portable computers, CD/DVD players, mp3 players, iPod, etc. They com- 

prise high-quality speakers, are light in weight and very comfortable to wear. They 

can be easily connected to a computer via a mini stereo plug. 

The headphones allow the users to listen only; however, some applications like live 

chats, videoconferencing and telecalling services demand the user to also speak at 

the same time. For such applications, a headset is used instead of a headphone. 

A headset is a combination of one or two speakers and a Figure 4.54 Headphone 

and Headset microphone with both the speaker and the microphone attached to 

a headstrap. The speaker(s) allows the person to hear the conversation and the 
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microphone allows the user to communicate with the person on the other end (see 

Figure 2.30). 

Figure 2.30: Headphone and Headset 

 

 
2.4 Computer Terminals 

 
A computer terminal is a special unit that can perform both input and output. A 

terminal is an I/O device that uses a keyboard for input and a monitor for output. 

Due to this reason, a terminal is also known as video display terminal (VDT). 

Terminals can be categorized into the following types: 

 
• Dumb Terminal: It refers to a terminal that has no processing or program- 

ming capabilities. It is designed to communicate exclusively with a host 

computer. Usually, it consists of a screen and keyboard used to access a host 

computer. It has electronics circuitry enough to interpret incoming instruc- 

tions from the host computer, to display characters on the screen, to interpret 

keystrokes on the keyboard and pass them on to the host computer. Gen- 

erally, dumb terminals are used for simple data entry or retrieval tasks. An 

example of a dumb terminal is one used by airline clerks at airport ticket and 

check-in counters. 

• Smart Terminal: A smart terminal has built-in processing capability and 

memory but does not have its own storage capacity. In comparison to the 

dumb terminal, a smart terminal can communicate, retrieve data and can 

perform a limited processing of its own, that is, editing or verifcation of data. 

However, this kind of terminal cannot be used for programming. They 
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are often found in local area networks in offices. 

 
• Intelligent Terminal: An intelligent terminal has memory and inbuilt micro- 

processors, thus also known as user-programmable terminal. This terminal 

can independently perform a certain number of jobs without even interacting 

with the mainframe. Although they are intelligent terminals, some worksta- 

tions are designed without disk drives. Due to this, restricted data cannot be 

downloaded or copied. 
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Let us Summarize 

 
1. An input device is an electromechanical device that accepts data or infor- 

mation from the user and translates the information into a form which the 

computer can interpret. 

2. Keyboards are the most commonly used data entry devices. By pressing 

down the keys of the keyboard, data are entered into the computer. 

3. Pointing devices are the input devices by which we can point out and select 

items rapidly from the multiple options displayed on the screen. These de- 

vices can also be used to create graphic elements on the screen such as lines, 

curves and freehand shapes. The common types of pointing devices available 

are the mouse, trackball, joysticks, touch screens and light pens. 

4. Mouse is a small hand-held pointing device which can be used to input com- 

mands or information. It contains two or three buttons and by pressing one 

of the buttons, the mouse either marks a place on the screen or makes selec- 

tions from the data on the screen. Common types of mouse action available 

are pointing, click, double-click, right-click and drag and drop. 

5. A trackball is an upturned mouse, with a movable ball on the top of a sta- 

tionary base. It is used to control the cursor movements and the actions on a 

computer screen. It allows the user to perform each of these tasks separately. 

6. Joystick is a device that moves in all directions and controls the movement 

of the pointer. It activates the computer with different parts and is used to 

control the cursor on the screen. 

7. Using a light pen, one can select the objects on the monitor by directly point- 

ing to the objects. It is useful for identifying a specific location. Since the 

light pen is a passive device with a sensor only, it provides no information 

when held over a blank part of the screen. 
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8. A touch screen is a type of display screen device that is placed on the com- 

puter monitor in order to allow direct selection or activation of the computer 

when somebody touches the screen. It registers the input when a finger or 

other object touches the screen. It consists of three main components: a touch 

sensor, a controller and a software driver. 

9. Trackpad (also referred to as touchpad) is a stationary pointing device that 

works by sensing the movement of fingers across a small sensitive surface 

(1.5 or 2 inches) and translating them into the pointer movement on the 

screen. 

10. Speech recognition is the technology by which sounds, words or phrases 

spoken by humans are converted into digital signals, and these signals are 

transformed into coding patterns where the meaning has been assigned. It is 

more generally called as sound recognition. 

11. Digital camera records images in an electronic form, that is, the image is 

represented in computer’s language of bits and bytes. It is a long string of 1s 

and 0s that represent all the tiny coloured dots or pixels that collectively 

make up the image. 

12. A webcam is a portable video camera, which captures live video or images 

that may be viewed in real time over the network or the Internet. 

13. A scanner is a device that scans an image and transforms the image to ASCII 

codes. These images can be edited, manipulated, combined and then printed. 

The common types of scanners are: handheld and flatbed. 

14. The optical character recognition (OCR) software translates the bitmap im- 

age of text to the ASCII codes that the computer can interpret as letters, 

numbers and special characters. 

15. The optical mark recognition (OMR) is the process of detecting the presence 

of intended marked responses. A mark registers significantly less light than 
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the surrounding paper. Optical mark reading is done by a special device 

known as optical mark reader. 

16. A magnetic ink character reader (MICR) is used to recognize the magnetic 

ink characters; it reads the characters by examining their shapes in a matrix 

form. 

17. Bar codes are machine-readable codes, represented in parallel vertical lines 

with varying widths. By the combination of these vertical lines (bars) and 

the spacing between them, bar codes represent the alphanumeric data. For 

reading these bar-coded data, a device is used, which is known as a bar code 

reader. 

18. An output device is an electromechanical device, which converts machine- 

readable data or information into human-readable form. The printed form of 

output is referred to as hard copy while the form of output displayed on the 

screen is referred to as soft copy. 

19. Based on the hard copy and soft copy outputs, the output devices are clas- 

sified into: hard copy and soft copy output devices. Printers, plotters and 

microfilms are the most commonly used hard copy output devices while 

monitors, voice response systems, projectors, electronic whiteboards, and 

headphones and headsets are some commonly used soft copy output devices. 

20. A printer is a device that prints information from the computer on to paper. 

The two major categories of printer technologies are impact printers and non- 

impact printers. 

21. An impact printer forms characters and graphics on a piece of paper by strik- 

ing a mechanism against an ink ribbon that comes into physical contact with 

the paper. It includes dot matrix printers, daisy wheel printers and drum 

printers. 

22. Printers that form characters and images without making direct contact be- 
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tween printing mechanism and paper are called non-impact printers. They 

are categorized as ink-jet printers and laser printers. 

23. Hybrid document reproduction apparatus (HYDRA) printer, popularly known 

as all-in-one printer, is a device that consolidates the capabilities of multiple 

devices in one machine. It may include some or all of the devices like printer, 

scanner, photocopier and fax machine. Plotters are special-purpose drawing 

devices, which reproduce graphic images on paper using a pen whose move- 

ments are controlled by the computer. The lines drawn by these devices are 

continuous and very accurate. Plotters are classified as pen plotters and elec- 

trostatic plotters. 

24. Computer output microfilm is an extremely high-speed, low-cost process, 

which records computer-generated information directly from the computer 

tape or cartridge to a miniaturized microfilm media. The microfilm product 

is in fiche or roll format, which can be duplicated rapidly and inexpensively. 

25. Computer monitor is used to display the keyed data on the screen and to 

receive messages and processed information from the computer. 

26. Cathode ray tube (CRT) is the most common type of monitor for the office 

and the home. In a CRT, an electron gun is used which fires electrons at 

groups of phosphor dots coating the inside of the screen. When the electrons 

strike the phosphor dots, they glow to give the colours. 

27. In liquid crystal display (LCD) screen, the backlight passes through the first 

of two polarizing filters. The polarized light then passes through a layer that 

contains thousands of liquid crystal blobs aligned in tiny containers known 

as cells. Electric leads around the edge of the LCD create an electric field 

that twists the crystal molecule, which lines the light up with the second 

polarizing filter and allows it to pass through. 

28. Although CRT and LCD displays are the most commonly used, other kinds 
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of displays also exist. Two of them are plasma display and thin-film electro- 

luminescent display. 

29. The standard computer system can talk with the addition of two components: 

a speech synthesizer and a screen reading software. A speech synthesizer 

is a software that converts text information into spoken sentences. Screen 

reading software enables the user to control the synthesizer. It allows a user 

to access, or view text that is present on the screen. 

30. Screen image projector is an output device, which is used to project informa- 

tion from a computer on to a large screen, so that it can be simultaneously 

viewed by a large group of people. Projectors are mainly of two types: LCD 

projectors and DLP projectors. 

31. Electronic whiteboard is an interactive presentation device that works elec- 

tronically to display digital images, drawings, and text in different colours. 

The whiteboard is generally mounted on the wall and is connected to a com- 

puter (through USB, serial port or wireless technology like Bluetooth) and 

projector. 

32. Headphone is an audio device equipped with a pair of speakers which are 

attached via a headstrap worn by the users. A headset is a combination of one or 

two speakers and a microphone with both the speakers and the microphone 

attached to a headstrap. 

33. Computer terminals, also called as display or video display terminals, en- 

able a computer to receive or deliver data through input and output devices, 

respectively. 
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Exercises 
 

Fill in the Blanks 
 

 

1. Mouse and light pen are examples of ................ input devices. 

 
2. Two basic methods used for optical character recognition (OCR) are ............... 

and 

 
3. is a machine-readable code in the form of parallel vertical lines. 

 
4. MICR stands for ............... 

 
5. The bar-coded data represent the ................. and a device, which is used for 

reading the bar-coded data, is known as ............... 

 
6. The most used layout of a keyboard is ............... 

 
7. The printed form of output is referred to as................ and the form of output, 

which is shown on a display screen, is referred to as............... 

 
8. An impact printer, which gives only alphanumeric output, is called............... 

 
9. plotters are computer graphics devices that use drum or flatbed 

paper holder. 

 
10. A non-impact printer that forms an image by spraying ink from a matrix of 

tiny jets is called ............... 

11. The mouse may be classified as ............... or ............... 

 
12. is the oldest printing technology. 

 
13. The quality of the monitor is generally judged by considering four basic 

terms ..............., ..............., ..............., and ............... 

14. The number of bits used to describe a pixel is known as ............... 
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15. A computer can talk to persons through a device known as............... 

 

Multiple-choice Questions 
 

 
1. is the most commonly used input device. 

 
(a) Keyboard 

(b) Mouse 

(c) Joystick 

(d) Scanner 

 
2. Mouse, trackball and joystick are the examples of ............... 

 
(a) Scanning devices 

(b) Storing devices 

(c) Pointing devices 

(d) Multimedia devices 

 
3. Which of the following is not a computer terminal? 

 
(a) Intelligent 

(b) Smart 

(c) Both (a) and (b) 

(d) None of these 

 
4. Which of the following technique is best suited for bank cheques? 

 
(a) OCR 

(b) OMR 

(c) BAR 

(d) MICR 
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5. Choose the most suitable device among the following for playing computer 

games. 

(a) Hand-held scanner 

(b) Joystick 

(c) Optical Mark Reader 

(d) Digital Camera 

 
6. Light pen is frequently used in ............... 

 
(a) Computer Aided Design 

(b) Word Processing 

(c) Presentation 

(d) Spreadsheet 

 
7. Choose the odd one out. 

 
(a) QWERTY 

(b) SULTRY 

(c) AZERTY 

(d) DVORAK 

 
8. Which of the following is not a pointing device? 

 
(a) Scanner 

(b) Trackball 

(c) Light Pen 

(d) Mouse 

 
9. Which of the following is not an output device? 

 
(a) Printer 
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(b) Keyboard 

(c) Monitor 

(d) Plotter 

 
10. With the combinations of ..............., ............... and ................. colours, other 

colours can be shown. 

 
(a) Red, Black, Blue 

(b) Yellow, Blue, Green 

(c) Red, Blue, Green 

(d) Black, White, Yellow 

 
11. Which of the following is used for both input and output? 

 
(a) Computer Terminals 

(b) Pen Plotter 

(c) Dot Matrix Printer 

(d) None of these 

 
12. The ................ is also called as letter quality printer. 

 
(a) Dot Matrix Printer 

(b) Ink Jet Printer 

(c) Daisy Wheel Printer 

(d) Laser Printer 

 
13. The ................ terminal is referred to as non-programmable terminal whereas 

............... terminal is referred to as user-programmable terminal. 

 
(a) Dumb, Intelligent 

(b) Dumb, Smart 
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(c) Smart, Intelligent 

(d) None of these 

 
14. An individual small dot, which one sees on the computer screen is called 

............... 

 
(a) Font 

(b) Character 

(c) Screen Point 

(d) Pixel 

 
15. LCD stands for ............... 

 
(a) Liquid Colour Display 

(b) Light Colour Display 

(c) Lithium Crystal Display 

(d) Liquid Crystal Display 

 

State True or False 
 

 

1. Any hardware item that is attached to the CPU is referred to as peripheral 

device. 

2. Impact printers are slower as compared to non-impact printers. 

 
3. The speed of a printer is measured by character per minute. 

 
4. Audio response is a soft copy output. 

 
5. Dot pitch can be changed by the user. 

 
6. Plotters are best suited for desktop publishing. 

 
7. Bank cheques are an example of bar code marking. 
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8. QWERTY is the most popular keyboard layout. 

 
9. A speech recognition system converts the computer text and commands into 

human spoken words. 

10. More pixels per square inch mean better resolution. 

 
11. A digital camera’s photographs can be stored in a computer’s hard disk. 

 
12. The most common aspect ratio used in computer monitors is 4:4. 

 
13. Raster scan monitors draw a picture one line at a time and for this reason they 

are referred to as vector displays, stroke-writing, or calligraphic displays. 

14. Ultrasonic acoustic waves are one of the most commonly used touch screen 

techniques. 

15. 16-bits colour allows up to 256 colours. 

 
Descriptive Questions 

 

1. Why are input and output devices necessary for a computer system? 

 
2. What are pointing devices? Discuss some of the commonly used pointing 

devices. 

3. What is a touch screen device? Explain with their advantages and disad- 

vantages and give some typical applications for which touch screen is most 

suitable as an input device. 

4. What is a speech recognition system? Explain its types and give logical 

reasons. Why do currently available speech recognition devices have limited 

success? 

5. What do you mean by optical scanning devices? Explain any four such de- 

vices. 
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6. Explain the different types of printers. Make a clear difference between them 

in terms of speed, cost and method of operation, and suggest suitable appli- 

cations. 

7. Describe the application areas where plotters are useful. Discuss the various 

types of plotters. 

8. What is speech synthesizer? How does it function? Give some of its typical 

applications. 

9. What is LCD? Differentiate between CRT and LCD monitors. 

 
10. Write short notes on the following: 

 
(a) Resolution 

(b) Aspect ratio 

(c) Dot pitch 

(d) Refresh rate 

(e) Colour depth 
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Chapter 3 

 
Computer Programming and 

Languages 

 
This chapter introduces the reader with the fundamentals of computer program- 

ming and languages. A computer program refers to the set of instructions needed 

for performing a particular task. Computer or programming language refers to the 

vocabulary and set of grammatical rules that are required to instruct a computer to 

perform a specific task. The chapter begins with the life cycle of program devel- 

opment and various programming tools which are essential for making a computer 

program. The discussion continues with various programming control structures 

and programming paradigms. Next, the chapter explains the evolution of various 

programming languages and generations of programming languages. The reader 

is also familiarised with the working of languge translators, namely, assembler, 

compiler, and interpreter. 
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3.1 Introduction 

 
The computer has emerged as the most useful machine in recent times. It can 

perform a variety of tasks like receiving data, processing it and producing useful 

results. However, being a machine, the computer cannot perform on its own. A 

computer needs to be instructed to perform even a simple task like adding two 

numbers. Computers work on a set of instructions called computer program, which 

clearly specify the ways to carry out a task. An analogy of this may be thought of 

as the instructions given by the manager or team leader to its team. The team 

members follow those instructions and accordingly perform their duties. Similarly, 

a computer also takes instructions in the form of computer programs to carry out 

the requested task. 

Now the question that arises is how human beings instruct computers. We, as hu- 

man beings, use natural languages such as English, Spanish or French to communi- 

cate. Similarly, a user communicates with the computer in a language understood 

by it. Note that human beings cannot interact directly with the computer using 

natural languages because thus far we have not developed such computers that can 

comprehend natural languages. Rather, the instructions, provided in the form of 

computer programs, are developed using computer or programming languages. 

This chapter provides some of the most prominent concepts related to computer 

programming and languages. 

 
3.1.1 Developing a Program 

 
As discussed earlier, a program consists of a series of instructions that a computer 

processes to perform the required operation. In addition, it also includes some 

fixed data required to perform the instructions and the process of defining those 

instructions and data. Thus, in order to design a program, a programmer must 
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determine three basic rudiments: 

 
• The instructions to be performed. 

 
• The order in which those instructions are to be performed. 

 
• The data required to perform those instructions. 

 

To perform a task using a program, a programmer has to consider various inputs 

of the program along with the process, which is required to convert the input into 

desired output. Suppose we want to calculate the sum of two numbers, A and B, 

and store the sum in C; here A and B are the inputs, addition is the process, and C 

is the output of the program (see Figure 3.1). 

To perform a task using a program, a programmer has to consider various inputs 

of the program along with the process, which is required to convert the input into 

desired output. Suppose we want to calculate the sum of two numbers, A and B, 

and store the sum in C; here A and B are the inputs, addition is the process, and C 

is the output of the program (see Figure 3.1). 

Figure 3.1: Program Performing a Task 

 

 
3.1.2 Program Development Cycle 

 
Before starting the process of writing a program (coding), the programmer has to 

determine the problem that needs to be solved. There are different approaches 

to problem solving. One common approach is to use the program development 

cycle, with the number of steps that may vary according to the person who has 

formalized the development. Often the process runs in a loop, for example, as the 

current process is completed, new demands appear and the development process 
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commences again. Illustrated in Figure 3.2 is the development cycle of a program, 

which includes the following phases. 

Figure 3.2: Program Development Cycle 

 

 
• Problem Analysis: The problem is analysed precisely and completely. Based on 

understanding, the developer knows about the scope within which the 

problem needs to be developed. 

• Task Analysis: After analysing the problem, the developer needs to develop 

various solutions to solve the given problem. From these solutions, the opti- 

mum solution is chosen, which can solve the problem comfortably and eco- 

nomically. 

• Algorithm Development: After selecting the appropriate solution, an algo- 

rithm is developed to depict the basic logic of the selected solution. An algo- 

rithm depicts the solution in logical steps (sequence of instructions). Further, 

an algorithm is represented by flowcharts, decision tables and pseudocodes. 

These tools make the program logic clear and they eventually help in coding. 

• Algorithm Testing: Before converting the algorithms into actual code, it 

should be checked for accuracy. The main purpose of checking the algorithm 

is to identify major logical errors at an early stage because logical errors are 

often difficult to detect and correct at later stages. The testing also ensures 

that the algorithm is a “true” one and it should work for both normal as well 

as unusual data. 
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• Coding: After meeting all the design considerations, the actual coding of the 

program takes place in the chosen programming language. Depending upon 

the application domain and available resources, a program can be written by 

using computer languages of different levels such as machine, assembly or 

high-level languages (HLL). 

• Testing and Debugging: It is common for the initial program code to con- 

tain errors. A program compiler and programmer-designed test data machine 

tests the code for syntax errors. The results obtained are compared with re- 

sults calculated manually from these test data. Depending upon the complex- ity 

of the program, several rounds of testing may be required. 

• Documentation: Once the program is free from all the errors, it is the duty 

of the program developers to ensure that the program is supported by suitable 

documentation. These documents should be supplied to the program users. 

Documenting a program enables the user to operate the program correctly. It 

also enables other persons to understand the program clearly so that it may, 

if necessary, be modified, or corrected by someone other than the original 

programmer. 

• Implementation: After documentation, the program is installed on the end 

user’s machine and the user is also provided with all the essential documents 

in order to understand how the program works. The implementation can be 

viewed as the final testing because only after using the program the user can 

point out the drawbacks (if any) and report them to the developers. Based on 

the feedback from users, the programmers can modify or enhance the 

program. 

• Maintenance and Enhancement: After the program is implemented, it 

should be properly maintained by taking care of the changing requirements 

of its users and the system. The program should be regularly enhanced by 
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adding additional capabilities. This phase is also concerned with detecting 

and fixing the errors, which were missed in the testing phase. Since this step 

generates user feedback, the programming cycle continues as the program is 

modified or reconstructed to meet the changing needs. 

 

3.2 Algorithm 

 
Algorithms are one of the most basic tools that are used to develop the problem- 

solving logic. An algorithm is defined as a finite sequence of explicit instructions 

that when provided with a set of input values produces an output and then termi- 

nates. To be an algorithm, the steps must be unambiguous and after a finite number of 

steps, the solution of the problem should be achieved. However, algorithms can 

have steps that repeat (iterate) or require decisions (logic and comparison) until the 

task is completed. 

Different algorithms may accomplish the same task, with a different set of instruc- 

tions, in more or less the same time, space and efforts. For example, two different 

recipes for preparing tea: one “add the sugar” while boiling the water and the other 

“after boiling the water” produce the same result. However, performing an 

algorithm correctly does not guarantee a solution, if the algorithm is flawed or not 

appropriate to the context. For example, preparing the tea algorithm will fail if 

there are no tea leaves present; even if all the motions of preparing the tea are per- 

formed as if the tea leaves were there. We use algorithms in our daily life. For 

example, to determine the largest number out of three numbers A, B and C, the 

following algorithm may be used. 
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The above-mentioned algorithm terminates after six steps. This explains the fea- 

ture of finiteness. Every action of the algorithm is precisely defined, hence there is 

no scope for ambiguity. 

Once an algorithm has been designed, it can be represented as a flowchart, pseu- 

docode or decision table, which are further expressed in programming language to 

develop computer programs. 

 

3.3 Flowchart 

 
A flowchart is a pictorial representation of an algorithm in which the steps are 

drawn in the form of different shapes of boxes and the logical flow is indicated by 

interconnecting arrows. The boxes represent operations and the arrows represent 

the sequence in which the operations are implemented. The primary purpose of 

the flowchart is to help the programmer in understanding the logic of the program. 

Therefore, it is always not necessary to include all the required steps in detail. 

Flowcharts outline the general procedure. Since they provide an alternative, visual 

way of representing the information flow in a program, program developers often 

find them very valuable. 

Algorithm: To Determine Largest of Three Numbers 
 

1. Start 

2. Read three numbers A, B, C 

3. Find the larger number between A and B and store it in MAX AB 

4. Find the larger number between MAX AB and C and store it in MAX 

5. Display MAX 

6. Stop 
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3.3.1 Flowchart Symbols 

 
Flowcharts can be compared with the blueprint of a building. Just as an archi- tect 

draws a blueprint before starting the construction of a building, a programmer 

draws a flowchart before writing a computer program. As in the case of the draw- 

ing of a blueprint, the flowchart is drawn according to defined rules and using 

standard flowchart symbols prescribed by American National Standard Institute 

(ANSI). Some standard symbols that are frequently required for flowcharts are 

shown in Figure 3.3. 

 
3.3.2 Benefits of Flowcharts 

 
A flowchart helps to clarify how things are currently working and how they could 

be improved. It also assists in finding the key elements of a process by drawing 

clear lines between the end of one process and the start of next one. Developing 

a flowchart establishes a common understanding among the participants about the 

process. Flowcharts help in revealing redundant or misplaced steps. They also help in 

establishing important areas for monitoring or data collection and to identify areas 

for improvement or increase in efficiency. The reasons for using flowcharts as a 

problem-solving tool are given below. 

 
• Makes Logic Clear: The main advantage of using a flowchart to plan a task 

is that it provides a pictorial representation of the task, which makes the logic 

easier to follow. The symbols are connected in such a way that they show 

the movement (flow) of information through the system visibly. The steps 

and how each step is connected to the next can be clearly seen. Even less 

experienced personnel can trace the actions represented by a flowchart, that 

is, flowcharts are ideal for visualizing fundamental control structures 

employed in computer programming. 



Computer Programming and Languages 

– Page 89 – 

 

 

 

 
 

Figure 3.3: Flowchart Symbols 
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• Communication: Being a graphical representation of a problem-solving 

logic, flowcharts are a better way of communicating the logic of a system to 

all concerned. The diagrammatical representation of logic is easier to com- 

municate to all the interested parties as compared to actual program code as 

the users may not be aware of all the programming techniques and jargons. 

• Effective Analysis: With the help of a flowchart, the problem can be anal- 

ysed in an effective way. This is because the analysing duties of the pro- 

grammers can be delegated to other persons, who may or may not know the 

programming techniques, as they have a broad idea about the logic. Being 

outsiders, they often tend to test and analyse the logic in an unbiased manner. 

• Useful in Coding: The flowcharts act as a guide or blueprint during the 

analysis and program development phase. Once the flowcharts are ready, the 

programmers can plan the coding process effectively as they know where to 

begin and where to end, making sure that no steps are omitted. As a result, 

error-free programs are developed in HLL and that too at a faster rate. 

• Proper Testing and Debugging: By nature, a flowchart helps in detecting 

the errors in a program, as the developers know exactly what the logic should 

do. Developers can test various data for a process so that the program can 

handle every contingency. 

• Appropriate Documentation: Flowcharts serve as a good program docu- 

mentation tool. Since normally programs are developed for novice users, 

they can take the help of the program documentation to know what the pro- 

gram actually does and how to use the program. 
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3.3.3 Limitations of Flowcharts 

 
A flowchart can be used for designing the basic concept of the program in pictorial 

form but cannot be used for programming purposes. Some of the limitations of the 

flowchart are given below. 

 
• Complex: The major disadvantage in using flowcharts is that when a pro- 

gram is very large, the flowcharts may continue for many pages, making 

them hard to follow. Flowcharts tend to get large very quickly and it is dif- 

ficult to follow the represented process. It is also very laborious to draw a 

flowchart for a large program. You can very well imagine the nightmare 

when a flowchart is to be developed for a program, consisting of thousands 

of statements. 

• Costly: Drawing flowcharts are viable only if the problem-solving logic is 

straightforward and not very lengthy. However, if flowcharts are to be drawn 

for a huge application, the time and cost factor of program development may 

get out of proportion, making it a costly affair. 

• Difficult to Modify: Due to its symbolic nature, any changes or modification to 

a flowchart usually requires redrawing the entire logic again, and redraw- ing 

a complex flowchart is not a simple task. It is not easy to draw thousands of 

flow lines and symbols along with proper spacing, especially for a large 

complex program. 

• No Update: Usually programs are updated regularly. However, the corre- 

sponding update of flowcharts may not take place, especially in the case of 

large programs. As a result, the logic used in the flowchart may not match 

with the actual program’s logic. This inconsistency in flowchart update de- 

feats the main purpose of the flowcharts, that is, to give the users the basic 

idea about the program’s logic. 
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3.4 Pseudocode 

 
Pseudocode is made up of two words: pseudo and code. Pseudo means imitation 

and code refers to instructions, written in a programming language. As the name 

suggests, pseudocode is not a real programming code, but it models and may even 

look like programming code. It is a generic way of describing an algorithm with- 

out using any specific programming language-related notations. Simply put, pseu- 

docode is an outline of a program, written in a form that can be easily converted 

into actual programming statements. Pseudocode uses plain English statements 

rather than symbols to represent the processes in a computer program. It is also 

known as PDL (program design language), as it emphasizes more on the design 

aspect of a computer program or structured English, because usually pseudocode 

instructions are written in normal English, but in a structured way. 

Pseudocode strikes a fine balance between the understandability and informality 

of a natural language like English and the precision of a computer program code. 

It is somewhat halfway between English and a programming language. If an al- 

gorithm is written in English, the description may be at such a high level that it 

may prove difficult to analyse the algorithm and then to transform it into actual 

code. If instead, the algorithm is written in code, the programmer has to invest a 

lot of time in determining the details of an algorithm, which he may choose not to 

implement (since, typically, algorithms are analysed before deciding which one to 

implement). Therefore, the goal of writing pseudocode is to provide a high-level 

description of an algorithm, which facilitates analysis and eventual coding, but at 

the same time suppresses many of the details that are insignificant. 

Pseudocode uses some keywords to denote programming processes. Some of them are 

as follows. 

 
• Input: READ, OBTAIN, GET and PROMPT 
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• Output: PRINT, DISPLAY and SHOW 

 
• Compute: COMPUTE, CALCULATE and DETERMINE 

 
• Initialize: SET and INITIALIZE 

 
• Add One: INCREMENT 

 

Since pseudocode is detailed yet readable, it can be inspected by the team of de- 

signers and programmers as a way to ensure that actual programming is likely 

to match the design specifications. It is better to catch errors at the pseudocode 

stage rather than correcting them in later stages as it would prove expensive. Once 

the pseudocode is accepted, it is transformed into actual program code using the 

vocabulary and syntax of the chosen programming language. The benefit of pseu- 

docode is that it enables the programmer to concentrate on the algorithms without 

worrying about all the syntactic details of a particular programming language. In 

fact, you can write pseudocode without even knowing what programming lan- 

guage you will use for the final implementation. Often computer textbooks use 

pseudocode in their examples so that all programmers can understand them, even 

if they do not know the same programming languages. 

 
3.4.1 Benefits of Pseudocode 

 
Programming can be a complicated process when the program requirements are 

complex in nature. Pseudocode provides a simple method of developing the pro- 

gram logic as it uses everyday language to prepare a brief set of instructions in the 

order in which they appear in the completed program. It allows the programmer 

to focus on the steps required to solve a program rather than on how to use the 

computer language. Some of the most significant benefits of pseudocode are as 

follows. 



Computer Programming and Languages 

– Page 94 – 

 

 

• Since it is language independent, it can be used by most programmers. It 

allows the developer to express the problem logic in plain natural language. 

• It is easier to develop a program from a pseudocode rather than from a 

flowchart or decision table. Programmers do not have to think about syn- 

taxes; they simply have to concentrate on the underlying logic. The focus is 

on the steps to solve a problem rather than on how to use the computer 

language. 

• The words and phrases used in pseudocode are in line with basic computer 

operations. This simplifies the translation from the pseudocode to a specific 

programming language. 

• Unlike flowcharts, pseudocode is compact and does not tend to run over 

many pages. Its simple structure and readability makes it easier to Modify. 

 
3.4.2 Limitations of Pseudocode 

 
Although pseudocode is a very simple mechanism to simplify problem-solving 

logic, it has its limitations. Some of the most notable limitations are as follows. 

• It does not provide a visual representation of the program’s logic. 

 
• There are no accepted standards for writing pseudocodes. Programmers use 

their own style of writing pseudocode. 

• It is quite difficult for the beginners to write pseudocode as compared to 

drawing a flowchart. 

 

3.5 Programming Languages 

 
Previously, we discussed that a computer needs to be instructed using computer 

programs to perform all its tasks. To write computer programs, a computer or pro- 



Computer Programming and Languages 

– Page 95 – 

 

 

gramming language is required, as computers do not understand natural languages 

(like English). A programming language consists of a set of characters, symbols 

and usage rules that allow the user to communicate with computers just as natural 

languages are used for communication among human beings. 

You might be wondering why natural languages are not used to instruct the com- 

puters. There are mainly two reasons behind it. Firstly, the natural languages 

(English, Spanish) are ambiguous, vaguely structured, and have very large (and 

ever changing) vocabularies. In contrast, computer languages have relatively few, 

exactly defined rules for composition of programs, and strictly controlled vocabu- 

laries in which unknown words must be defined before they can be used. Secondly, 

in case of natural languages, we can understand even while using poor grammar 

and vocabulary. However, in the case of programming languages, the rules are 

very rigid and the programmer has to follow all the specified rules to create an 

accurate program and to obtain the desired results. 

 
3.5.1 Types of Programming Languages 

 
Computers understand only one language and that is binary language or the lan- 

guage of 0s and 1s. In the initial years of computer programming, all the in- 

structions were given in binary form only. Although these programs were easily 

understood by the computer, it proved too difficult for a normal human being to 

remember all the instructions in the form of 0s and 1s. Therefore, the computer re- 

mained a mystery to a common person until other languages such as assembly and 

HLL were developed which were easier to learn and understand. These languages 

use commands that have some degree of similarity with English (such as “if else”, 

“exit”). Programming languages can be divided into three major categories: 

• Machine Language: It is the native language of computers. It uses only 0s 

and 1s to represent data and instructions. 
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• Assembly Language: It correspondences symbolic instructions and exe- 

cutable machine codes and was created to use letters instead of 0s and 1s. 

• High-level Language: These languages are written using a set of words and 

symbols following some rules similar to a natural language such as En- glish. 

The programs written in HLL are known as source programs and these 

programs are converted into machine-readable form by using compilers or 

interpreters. 

 
Note: Together, machine and assembly language are also known as low-level lan- 

guages. 

 

3.6 Generations of Programming Languages 

 
Since early 1950s, programming languages have evolved tremendously. This evo- 

lution has resulted in the development of hundreds of different languages. With 

each passing year, the languages become user-friendly and more powerful. We 

can illustrate the development of all the languages in five generations. 

First generation languages are machine languages, in which instructions are par- 

ticular sequences of 0s and 1s that digital computers can understand. Second gen- 

eration languages, assembly languages, allow programmers to use meaningful ab- 

breviations for machine-specific instructions in place of the incomprehensible 0s 

and 1s form. Each instruction in an assembly language translates directly to a ma- 

chine language instruction using a tool called an assembler. Programming became 

somewhat easier, but many users still wanted floating-point numbers and array in- 

dexing. Since these capabilities were not supported in hardware, HLL had to be 

developed to support them. The next few sections discuss the five generations of 

languages and how they revolutionized the computer industry. 
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3.6.1 First Generation: Machine Language 

 
The first language was binary, also known as machine language, which was used in 

the earliest computers and machines. We know that computers are digital devices, 

which have only two states, ON and OFF (1 and 0). Therefore, every instruction 

and data should be written using 0s and 1s. Machine language is also known as 

the computer’s “native” language as this system of codes is directly understood by 

the computer. 

 
3.6.2 Second Generation: Assembly Language 

 
The complexities of machine language led to the search of another language: the 

assembly language, developed in the early 1950s and its main developer was IBM. 

However, Jack Powell, Bob Nevelen, Clement and Michael Bradly also helped in 

the development of the assembly language. It was a stepping-stone for all subse- 

quent language development. Assembly language allows the programmer to in- 

teract directly with the hardware. This language assigns a mnemonic code to each 

machine language instruction to make it easier to remember or write. It allows bet- 

ter human-readable method of writing programs as compared to writing in binary 

bit patterns. However, unlike other programming languages, assembly language 

is not a single language, but a group of languages. Each processor family (and 

sometimes individual processors within a processor family) has its own assembly 

language. 

 
3.6.3 Third Generation: High-level Language 

 
During 1960s, computers started to gain popularity and it became necessary to de- 

velop languages that were more like natural languages, such as English, so that 

a common user could use the computer efficiently. Since assembly language re- 
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quired deep knowledge of computer architecture, it demanded programming as 

well as hardware skills to use computers. Due to the computer’s widespread usage, the 

early 1960s saw the emergence of the third generation programming languages 

(3GL). Languages such as COBOL, FORTRAN, BASIC and C are examples of 

3GLs and are considered HLL. 

HLL are similar to the English language. Programs written using these languages 

can be machine independent. A single high-level statement can substitute several 

instructions in machine or assembly language. Unlike assembly and machine pro- 

grams, high-level programs may be used with different types of computers with 

little or no modification, thus reducing the re-programming time. 

In a high-level language, programs are written in a sequence of statements to solve 

a problem. For example, the following BASIC code snippet will calculate the sum 

of two numbers. 

 
 

 
The first two statements store 10 in variable X (memory location name) and 20 in 

variable Y, respectively. The third statement again creates a variable named SUM, 

which will store the summation of X and Y value. Finally, the output is printed, 

that is, the value stored in SUM is printed on the screen. 

Translating High-level Language into Machine Language: Since computers 

understand only machine language, it is necessary to convert the high-level lan- 

guage programs into machine language codes. This is achieved by using language 

translators or language processors, generally known as compilers, interpreters or 

other routines that accept statements in one language and produces equivalent 

statements in another language (see Figure 3.4). 

LET X = 10 

LET Y = 20 

LET SUM = X + Y 

PRINT SUM 
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Figure 3.4: Program Translation Hierarchy 

 
 

Compiler: A compiler is a kind of translator that translates a program into an- 

other program, known as target language. Usually, the term compiler is used for 

language translator of high-level language into machine language. The compiler 

replaces a single high-level statement with a series of machine language instruc- 

tions. A compiler usually resides on a disk or other storage media. When a pro- 

gram is to be compiled, its compiler is loaded into main memory. The compiler 

stores the entire high-level program, scans it and translates the whole program into 

an equivalent machine language program. During the translation process, the com- 

piler reads the source program and checks the syntax (grammatical) errors. If there 

is any error, the compiler generates an error message, which is usually displayed 

on the screen. In case of errors, the compiler will not create the object code until 

all the errors are rectified. 

Once the program has been compiled, the resulting machine code is saved in an 

executable file, which can be run on its own at any time. To be precise, once the 

executable is generated, there is no need for the actual source code file. Anyway, 

it is worthwhile to keep the source file(s) because if the source code is modified, 

it is necessary to recompile the program again to regenerate the executable file 

containing amendments. 

Interpreter: Unlike compilers, an interpreter translates a statement in a program 

and executes the statement immediately, before translating the next source lan- 

guage statement (see Figure 3.5). When an error is encountered in the program, 



Computer Programming and Languages 

– Page 100 – 

 

 

the execution of the program is halted and an error message is displayed. Simi- lar 

to compilers, every interpreted language such as BASIC and LISP has its own 

interpreters. 

Figure 3.5: (a) Working of a Compiler (b) Working of an Interpreter 

 

 
3.6.4 Fourth Generation 

 
Fourth generation languages (4GLs) have simple, English-like syntax rules, com- 

monly used to access databases. The 3GLs are considered as procedural languages 

because the programmer must list each step and must use logical control structures 

to indicate the order in which instructions are to be executed. 4GLs, on the other 

hand, are non-procedural languages. The non-procedural method is simply to state 

the needed output instead of specifying each step one after another to perform a 

task. In other words, the computer is instructed what it must do rather than how a 

computer must perform a task. 

The non-procedural method is easier to write, but has less control over how each 

task is actually performed. When using non-procedural languages, the methods 

used and the order in which each task is carried out is left to the language itself; 

the user does not have any control over it. In addition, 4GLs sacrifice computer 

efficiency in order to make programs easier to write. Hence, they require more 

computer power and processing time. However, with the increase in power and 
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speed of hardware and with diminishing costs, the uses of 4GLs have spread. 

 
4GLs have a minimum number of syntax rules. Hence, common people can also 

use such languages to write application programs. This saves time and allows 

professional programmers for more complex tasks. The 4GLs are divided into 

three categories: 

 
• Query Languages: They allow the user to retrieve information from databases 

by following simple syntax rules. For example, the database may be re- 

quested to locate details of all employees drawing a salary of more than 

$10,000. Structured Query Language (SQL) and IBM’s Query-By-Example 

(QBE) are examples of query languages. 

• Report Generators: They produce customized reports using data stored in 

a database. The user specifies the data to be in the report, the report’s format, 

and whether any subtotals and totals are needed. Often report specifications 

are selected from pull-down menus, making report generators very easy to 

use. Examples of report generators are Easytrieve Plus by Pansophic and 

R&R Relational Report Writer by Concentric Data Systems. 

• Application Generators: With application generators, the user writes pro- 

grams to allow data to be entered into the database. The program prompts 

the user to enter the needed data. It also checks the data for validity. Cin- 

com System’s MANTIS and ADS by Cullinet are examples of application 

generators. 

 
3.6.5 Fifth Generation: Very High-level Languages 

 
Fifth generation languages are just the conceptual view of what might be the fu- 

ture of programming languages. These languages will be able to process natural 

languages. The computers would be able to accept, interpret and execute instruc- 
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tions in the native or natural language of the end users. The users will be free from 

learning any programming language to communicate with the computers. The 

programmers may simply type the instruction or simply tell the computer by way 

of microphones what it needs to do. Since these languages are still in their infancy, 

only a few are currently commercially available. They are closely linked to 

artificial intelligence and expert systems. 
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Let us summarize 

 
1. A computer needs to be instructed to perform all its tasks. These instructions 

are provided in the form of a computer program. Programming involves 

many stages such as problem definition, task analysis, developing algorithm, 

testing algorithm, coding, program testing, documentation, implementation, 

and maintenance and enhancement. 

2. An algorithm is defined as a finite sequence of explicit instructions that when 

provided with a set of input values produces an output and then terminates. 

Algorithms can be represented as flowchart, pseudocode or decision table. 

3. A flowchart is a pictorial representation of an algorithm in which the steps 

are drawn in the form of different shapes of boxes and the logical flow is 

indicated by interconnecting arrows. The boxes represent operations and the 

arrows represent the sequence in which the operations are implemented. 

4. Pseudocode is a generic way of describing an algorithm without the use of 

any specific programming language-related notations. It is an outline of a 

program, written in a form, which can easily be converted into real pro- 

gramming statements. Pseudocode uses plain English statements rather than 

symbols to represent the processes in a computer program. 

5. Program statements that affect the order in which statements are executed, 

or that affect whether statements are executed, are called control structures. 

They affect the flow of simulation code since a control structure evaluates 

statements and then executes code according to the result. 

6. Programming language is a language that a user employs to interact with the 

computer. It can be divided into three major categories: machine, assembly 

and high-level language. 
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7. First generation language is the machine language in which instructions are 

in the form of 0s and 1s. Second generation language is the assembly lan- 

guage in which mnemonic code is assigned to each machine language in- 

struction to make it easier to remember and write. 3GLs are machine inde- 

pendent, use HLL to write programs, and thus need language translators to 

translate the high-level code into machine code. 4GLs, also called as non- 

procedural languages, use minimum syntax rules and are categorized into 

query languages, report generators and application generators. Fifth gener- 

ation language is in the development stage. The computer will be able to 

accept, interpret and execute the instruction in the natural language of the 

user. 

8. Linker is a program that links together several object modules and libraries to 

form a single, coherent executable program. Loader is a program that brings 

an executable file residing on a disk into a memory. It is also responsible for 

performing basic tasks such as linking, loading and relocation. 

9. A good programming language should be easier to use and be portable. It 

should incur the minimum cost and provide concurrent support. 
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Exercises 
 

Fill in the Blanks 
 

 

1. The sequence of instructions that instruct the computer to carry out a specific 

task is called.................. 

2. An algorithm can be represented as.................or.................... 

 
3. Broadly, programming can be classified into.............,...............and. ............. approaches. 

 
4. A program that translates the assembly language code into machine language 

code is called................. 

5. The part of operating system that brings an executable file residing on disk 

into memory and start running is...................... 

6. Compiler and interpreter are also called............ 

 
7. The two-part forms of machine language instructions are..................and................ 

 
8. The two categories of loader are.............and............ 

 
9. language is very close to the hardware. 

 
10. COBOL, FORTRAN and C are examples of............ 

 

Multiple-choice Questions 
 

 

1. The semantic and syntax errors in the program are checked in................. 

 
(a) Coding Phase 

(b) Testing Phase 

(c) Implementation Phase 

(d) Analysis Phase 
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2. Choose the odd one out................. 

 
(a) Abstraction 

(b) Encapsulation 

(c) Inheritance 

(d) Linking 

 
3. Flow lines in a flowchart are used to connect............ 

 
(a) Two Terminals 

(b) Two Connectors 

(c) Two Input/Output 

(d) All of these 

 
4. Programming tools helps in.................. 

 
(a) Producing readable code 

(b) Making the program logic easier 

(c) Reducing the size of programs 

(d) None of these 

 
5. A high-level language is a programming language that is....................... 

 
(a) Easier to use 

(b) Considered a first generation language 

(c) Considered a third generation language 

(d) Both (a) and (c) 

 
6. What consists of instructions written as a series of 1s and 0s? 

 
(a) Query Language 

(b) Assembly Language 
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(c) Machine Language 

(d) None of these 

 
7. Which of the following was a disadvantage of the first generation language? 

 
(a) Machine dependency 

(b) Less efficient 

(c) Need for more disk space 

(d) All of these 

 
8. Good programming language has the following features:................ 

 
(a) Portable, Safe 

(b) Reliable, Good Performance 

(c) High Cost 

(d) Only (a) and (b) 

 
9. Query languages comes under.............. 

 
(a) Third Generation 

(b) Fourth Generation 

(c) Fifth Generation 

(d) None of these 

 
10. Which of the following program control structure allows the program to 

make a choice between two alternate paths depending upon the condition? 

(a) Sequence 

(b) Loop 

(c) Selection 

(d) None of these 



Computer Programming and Languages 

– Page 108 – 

 

 

State True or False 

 

1. The graphical representation of an algorithm is called flowchart. 

 
2. The generic way of describing an algorithm without the use of programming 

language is known as program. 

3. The keyword, DETERMINE, used in a pseudocode is an input operation. 

 
4. The terminal symbol in a flowchart represents start of program logic. 

 
5. Programming is the art and science of creating computer programs. 

 
6. A program that links several object modules and libraries to form a single, 

coherent program is called linker. 

7. The language translator that translates the programs written in high-level lan- 

guage into its corresponding machine code is called assembler. 

8. Machine language is also called low-level language. 

 
9. Pseudocode can be compiled by a program compiler. 

 
10. The diamond-shape symbol in the flowchart signifies processing. 

 
Descriptive Questions 

 

 

1. Explain the program development cycle with the help of a block diagram. 

 
2. Define an algorithm. List the characteristics of a good algorithm. 

 
3. Define a flowchart. List some important reasons for using flowcharts. 

 
4. What are the advantages and disadvantages of using a pseudocode? 

 
5. Explain the features of a good programming language. 

 
6. Describe the classification of programming languages. 
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7. Write short notes on the following. 

 
(a) Compiler 

(b) Interpreter 

(c) Loader 

(d) Linker 
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Chapter 4 

 
Practical Notes 

 
5.1 Microsoft Office Word 2003 

 
• Word processing is the manipulation of characters, words, text, numbers, 

sentences, and paragraphs in the document so that they are error-free and 

looks attractive. 

• To open Microsoft Word, click start, point to All Programs, and then select 

Microsoft Word. 

• To get help, click the Microsoft Word 

 
• Help button (images) on the Standard toolbar. Alternatively, select Microsoft 

Office Word Help from the Help menu. 

• To create a new document, click on New Blank Document button (images) 

on the Standard toolbar. Alternatively, select New from the File menu. 

• To open an existing document, click on the Open button (images) on the 

Standard toolbar. Alternatively, select Open from the File menu. 

• To save the document, Microsoft Word provides two menu options, namely, 
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Save and Save As. By default, Microsoft Word document files are saved with 

.DOC extension, although it can also be saved in other file formats like .TXT, 

.RTF, and .HTML. 

 
• To close the document, select Close from the File menu. 

 
• Formatting is the process of determining how the typed text will appear on 

a printed page. It is applied by altering the appearance of text by setting the 

font type and font size, line spacing, and colour. To format the text, first 

select the text to be formatted and then use various buttons on the Formatting 

toolbar. Text can also be formatted by using the Font dialog box, which can 

be displayed by selecting Font from the Format menu. 

• To highlight the text use the Highlight button (images) from the Formatting 

toolbar. In case you want to change the colour of the text, use the Font Color 

button (images) from the Formatting toolbar. 

• To align or indent a paragraph, use the appropriate buttons on the Formatting 

toolbar. A paragraph can also be formatted using the Paragraph dialog box, 

which can be displayed by selecting Paragraph from the Format menu. 

• A style is a set of formatting specifications that can automatically be applied 

to the text. To apply a style, place the cursor in the paragraph where the style 

is to be applied. Then click the Style drop-down box on the Formatting 

toolbar and select a style by clicking on it. 

• The Format Painter is a time-saving feature for quickly copying the format of 

a block of text. This tool can be used by clicking the Format Painter button 

(images) on the Standard toolbar. 

• To move the text, choose Cut from the Edit menu. To copy the text, choose 

Copy from the Edit menu. To paste the cut or copied text or image, choose 

Paste from the Edit menu. 
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• To find and replace text within the document use the Find and Replace dialog 

box, which can be displayed by selecting Find from Edit menu. 

• To undo the last action, select Undo from the Edit menu. To redo the last 

undo action, select Redo from the Edit menu. You can also use the Undo 

button (images) and Redo button (images) from the Standard toolbar. 

• To use bullets and numbering, first select the text you want to format. Next, 

use the Bullets (images) or Numbering (images) button on the Formatting 

toolbar. 

• Headers are text that appears at the top of every page, and footers contain 

text that appears at the bottom of each page. To create a header and footer in 

a document, select Header and Footer from the View menu, or double-click 

on the header area of the document. 

• Tables can be created by using the Insert Table dialog box, which can be 

displayed by selecting Insert and then Table from the Table menu. Another 

way of creating a table is to click the Insert Table button (images) on the 

Standard toolbar and then dragging the mouse along the grid to highlight the 

number of rows and columns for the table. 

• Microsoft Word automatically checks the spelling and grammar as you type 

the text and provides visual clues about the spelling and grammar. Mis- 

spelled words are underlined in red, while sentences with grammatical flaws 

are underlined in green. 

• Microsoft Word has the Thesaurus feature to replace a word with its syn- 

onym or antonym. This feature can be used by selecting Language and then 

Thesaurus from the Tools menu. 

• To add a picture from an existing file, use the Insert Picture dialog box, which 

can be displayed by selecting Picture and then From File from the Insert 
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menu. 

 
• Microsoft Word comes with its own set of pictures in the Clip Gallery. This 

gallery includes a wide variety of clip art that makes it easy for you to en- 

hance your documents with professionally designed images. To add a Clip 

Art from the Clip Gallery use the Insert ClipArt dialog box, which can be 

displayed by selecting Picture and then Clip Art from the Insert menu. 

• To use AutoShapes, select Picture and then AutoShapes from the Insert menu. 

Alternatively, use the AutoShapes menu from the Drawing toolbar. 

• To use WordArt, select Picture and then WordArt from the Insert menu. Al- 

ternatively, use the WordArt button (images) from the Drawing toolbar. 

• Page margins determine the distance between the text and the edge of the 

paper. To specify the margins in the document use the Page Setup dialog 

box, which can be displayed by selecting Page Setup from the File menu. 

• Print preview is a way to review the appearance of the printed document on- 

screen before printing the final output. To view the document in print preview 

mode, choose Print Preview from File menu or click the Print Preview button 

(images) on the Standard toolbar. 

• To print a document, click the Print button (images) on the Standard toolbar. 

Alternatively, use the Print dialog box, which can be displayed by selecting 

Print from the File menu. 
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5.2 Microsoft Office Excel 2003 

 
• Microsoft Excel is a spreadsheet program that allows you to perform various 

calculations, estimations, and formulations with data. It is the electronic 

counterpart of a paper ledger sheet, which consists of grid of columns and 

rows. 

• To open Microsoft Excel, click Start, point to All Programs, then point to 

Microsoft Office, and then select Microsoft Office Excel 2003. 

• To create a new workbook, click on New button (images) on the Standard 

toolbar. Alternatively, select New from the File menu. 

• To open an existing workbook, click on the Open button (images) on the 

Standard toolbar. Alternatively, select Open from the File menu. 

• To save the workbook, Microsoft Excel provides two menu options, namely 

Save and Save As. 

• To close the workbook, select Close from the File menu. 

 
• To find and replace text within the worksheet use the Find and Replace dialog 

box, which can be displayed by selecting Find and Replace from the Edit 

menu. 

• To undo the last action, select Undo from the Edit menu. To redo the last 

undo action, select Redo from the Edit menu. You can also use the Undo 

button (images) and Redo button (images) from the Standard toolbar. 

• In Excel, numerical data can be easily converted into a chart for graphical 

presentation of the data. Charts provide more visual clarity than tables of 

data and, therefore, have more impact. 
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• One of the simplest and easiest methods to create a chart is by using the Chart 

Wizard. This wizard helps in creating a chart by displaying a series of dialog 

boxes. 

• Print preview is a way to view the printed workbook on-screen before print- 

ing the final output. To view a worksheet in the print preview mode, choose 

Print Preview from File menu or click the Print Preview button (images) on 

the Standard toolbar. 

• To print a worksheet, click the Print button (images) on the Standard toolbar. 

Alternatively, use the Print dialog box, which can be displayed by selecting 

Print from the File menu. 
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5.3 Microsoft Office PowerPoint 2003 

 
• Microsoft PowerPoint 2003 is powerful, yet easy-to-use presentation soft- 

ware. Its primary purpose is to help you design professional-style presenta- 

tions quickly and easily. 

• Click Start, point to All Programs, then point to Microsoft Office, and then 

select Microsoft Office PowerPoint 2003. 

• A new presentation can be created using the AutoContent wizard, Design 

Template, and Blank presentation. 

• To open an existing presentation, click on the Open button (image) on the 

Standard toolbar. Alternatively, select Open from the File menu. 

• To save a presentation, Microsoft PowerPoint provides two menu options, 

namely Save and Save As. By default, Microsoft PowerPoint files are saved 

with .PPT extension. 

• To close the presentation, select Close from the File menu. 

 
• PowerPoint provides different types of screen layouts for constructing pre- 

sentation in addition to the Slide Show. View is a way in which one can see 

and work with the presentation and slides. 

• A presentation is created using the slides, which contains text, graphics, an- 

imations, and so on. PowerPoint is designed in a way to give a consistent 

appearance to your slides. There are two ways in PowerPoint, which help 

you to choose the look of your slides: design template and masters. 

• Design templates contain colour schemes, slide and notes masters with cus- 

tom formatting, and fonts, all designed to create a desired look. 



Practical Notes 

– Page 117 – 

 

 

• Masters in PowerPoint are used to control many facets of the slides such 

as backgrounds, font typeface, font size, colours, bullets and locations for all 

the main components, tab, and indent. PowerPoint has three masters, namely 

Slide Master, Notes Master, and Handouts Master. 

• Slides can be added in the outline view or in the slide view. To insert slide, 

select New Slide from the Insert menu, or click the New Slide (images) but- 

ton on the Standard toolbar. This displays New Slide dialog box from which 

you can choose the desired layout. 

• In PowerPoint, you can navigate to the next and previous slides by follow- 

ing any of the five view options, that is, Normal, Outline, Slide View, Slide 

Sorter, and Slide Show. 

• You can change the appearance of your slide background by changing its 

colour, shade, pattern, or texture. PowerPoint contains a number of pre- 

defined backgrounds or, if needed, you can create your own background. 

• There are a number of ways in which the text can be added into the slides. 

Text can be added using text placeholder, text box, an AutoShape, and Wor- 

dArt. 

• Formatting is the process of determining how the typed text will appear on 

a printed page.   It is applied by altering the appearance of text by setting the 

font type and font size, line spacing, and colour. To format the text, first select 

the text to be formatted, and then use various buttons on the Formatting toolbar. 

Text can also be formatted by using the Format menu. 

• In PowerPoint 2003, graphical elements can help you create eye-catching 

slides for a presentation. Graphics are frequently used with text to add em- 

phasis and visual impact. PowerPoint 2003 gives you the option of adding 

AutoShapes, WordArt, and ClipArt. 
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• A presentation can be made more interactive and interesting by adding mul- 

timedia effects such as animations, video, and sound effects to the slides. 

This helps in capturing audience’s attention as multimedia content can of- 

ten communicate more information than a slide, which contains only few 

sentences. 

• Animation effects are added to grab the audience’s attention as well as to 

reinforce the point that needs to be highlighted. Animation can be special 

sound or visual effects which can be added to the text or other objects such 

as a chart or picture. 

• Transition effects are used to insert effects between slides. They are also 

used to indicate a new section of a presentation or to emphasize a certain 

slide. You can choose from a variety of transitions, which are present in 

PowerPoint 2003. 

• After you have finished with creating slides, working with text and graph- 

ics, adding transition and animation effects to the slides, the next thing is to 

view all the slides collectively as a presentation. PowerPoint 2003 provides a 

number of ways to review and deliver presentations so that they are well de- 

signed and look professional. You can view the presentation as a slide show 

in the Slide view. 

• You can add time between the slides in the slide show. This may be required 

when there is some narration over the slides, or there is some graphical rep- 

resentation, which requires a proper explanation. 

• Sometimes, presentation may be created for business or professional use. For 

example, you may create a presentation, which is to be delivered at some con- 

ference. To give a presentation all you have to do is bring your presentation 

file with you. This approach is suited for small presentations, but it may not 

work that well for larger presentations especially one with lots of graphics. 
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PowerPoint contains a useful feature called Package for CD, which solves 

the above problem. 

• To print a presentation, click the Print button (images) on the Standard tool- 

bar. Alternatively, use the Print dialog box, which can be displayed by se- 

lecting Print from the File menu. 

• PowerPoint provides four options while printing–Slides, Handouts, Note 

Pages, and Outline View. 


